
Pro Tools Avid® Unity 
MediaNetwork™

Version 4.0



Legal Notices

This guide is copyrighted ©2007 by Digidesign, a division of 
Avid Technology, Inc. (hereafter “Digidesign”), with all rights 
reserved. Under copyright laws, this guide may not be 
duplicated in whole or in part without the written consent of 
Digidesign.

003, 003 Rack, 96 I/O, 96i I/O, 192 Digital I/O, 192 I/O, 
888|24 I/O, 882|20 I/O, 1622 I/O, 24-Bit ADAT Bridge I/O, 
AudioSuite, Avid, Avid DNA, Avid Mojo, Avid Unity, Avid Unity 
ISIS, Avid Unity MediaNetwork, Avid Xpress, AVoption, 
AVoption|V10, Beat Detective, Bruno, Command|8, Control|24, 
D-Command, D-Control, D-Fi, D-fx, D-Show, DAE, Digi 002, 
Digi 002 Rack, DigiBase, DigiDelivery, Digidesign, Digidesign 
Audio Engine, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiDrive, DigiRack, DigiTest, 
DigiTranslator, DINR, DV Toolkit, EditPack, Impact, Interplay, 
M-Audio, MachineControl, Maxim, Mbox, MediaComposer, 
MIDI I/O, MIX, MultiShell, OMF, OMF Interchange, PRE, 
ProControl, Pro Tools M-Powered, Pro Tools, Pro Tools|HD, 
Pro Tools LE, QuickPunch, Reel Tape, Reso, Reverb One, 
ReVibe, RTAS, Smack!, SoundReplacer, Sound Designer II, 
Strike, Structure, SYNC HD, SYNC I/O, Synchronic, TL Space, 
Velvet, and X-Form are trademarks or registered trademarks of 
Digidesign and/or Avid Technology, Inc. All other trademarks 
are the property of their respective owners.

Product features, specifications, system requirements, and 
availability are subject to change without notice.

PN 9329-56834-00 REV A 07/07

Comments or suggestions regarding our documentation?
email: techpubs@digidesign.com



Contents iii

contents

Chapter 1. Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

Avid Unity MediaNetwork Capabilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

DigiTranslator 2.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

Avid Interplay . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

Overview of a MediaNetwork System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2

AAF, OMF, and MXF Basics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3

Embedded Media and Linked Media . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

Frame-Rate Accurate Video Editing and Sample-Rate Accurate Audio Editing . . . . . . . . . . . . . .  6

System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8

About Avid Unity MediaNetwork Guides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8

Support for Avid Unity MediaNetwork  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Conventions Used in This Guide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

About www.digidesign.com  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Chapter 2. Configuring a Workstation as a MediaNetwork Client . . . . . . . . . . . . . . . .  11

Installation Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Installing Media Station|PT or Pro Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Installing MediaNetwork Client Hardware  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Installing MediaNetwork Client Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14



Pro Tools Unity MediaNetwork Guideiv

Chapter 3. Using a Client in a MediaNetwork System. . . . . . . . . . . . . . . . . . . . . . . . . .  17

Getting Started Using a Workstation as a MediaNetwork Client. . . . . . . . . . . . . . . . . . . . . . .  17

Logging into a MediaNetwork System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

Assigning the Workspace Drive Letter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

Mounting and Unmounting Workspaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Changing the User  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Configuring the Pro Tools|HD Playback Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Configuring Pro Tools Session Settings for a New Session  . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Performance Guidelines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22

Sharing Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

Destructive Editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

Chapter 4. Avid Unity MediaNetwork Workflows for Pro Tools . . . . . . . . . . . . . . . . . .  27

Exporting Audio and Video from Media Composer 2.5 and Higher . . . . . . . . . . . . . . . . . . . . .  27

Exporting Audio and Video using a Version of Media Composer Prior to 2.5 . . . . . . . . . . . . . .  36

Importing Audio and Video into Pro Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

Editing Audio in Pro Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

Exporting Audio from Pro Tools for Avid Editing Applications. . . . . . . . . . . . . . . . . . . . . . . . .  51

Importing Audio into an Avid Application from Pro Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . .  55

Synchronizing Audio with an Avid Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

Appendix A. PCI and PCIe Slot Configurations for Avid Video Peripherals . . . . . . . .  63

Summary of Recommended Windows PCI and PCIe Slot Configurations  . . . . . . . . . . . . . . . .  63

Summary of Mac PCI and PCIe Slot Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  66

HP xw8400 PCI and PCIe Slot Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  67

HP xw9300 PCI and PCIe Slot Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  74

Dell Precision 690 750w Recommended PCI and PCIe Slot Configurations  . . . . . . . . . . . . . .  80

Mac PCI and PCIe Slot Configurations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  91



Chapter 1: Introduction 1

chapter 1

Introduction

This guide explains how to configure a Pro Tools 
or Media Station|PT workstation as a MediaNet-
work client within an Avid Unity MediaNetwork 
system, as well how to exchange audio and 
video media sequences between Pro Tools, 
Media Station|PT, and Avid application clients 
attached to a MediaNetwork system.

This guide is written for Unity administrators, 
Pro Tools users, and Avid users.

Avid Unity MediaNetwork 
Capabilities
Avid Unity MediaNetwork is a Fibre Channel 
shared storage system that lets users of Avid, 
Pro Tools, and Media Station|PT share the same 
media, as follows:

• Stream audio and video media in real time.

• Configure up to nine users on the same Medi-
aNetwork system.

• Share AAF, OMF, and MXF audio and video se-
quences and media (DigiTranslator required).

• Share AAF, OMF, and MXF sequences using 
the Avid Interplay asset management system 
(Avid Interplay system required).

DigiTranslator 2.0
Use DigiTranslator to convert AAF and OMF se-
quences into Pro Tools session files. You can 
also use it to export audio material from 
Pro Tools sessions to AAF sequences or OMF se-
quences and files for import into other systems.

Avid Interplay
Avid Interplay with the Pro Tools Avid Interplay 
option lets Pro Tools and Avid users work within 
the same asset management system. 

For more information, refer to the Digi-
Translator 2.0 Guide.

Refer to the Pro Tools Avid Interplay Guide 
for detailed information.



Pro Tools Unity MediaNetwork Guide2

Overview of a MediaNetwork 
System
This guide describes how to configure and work 
with a Pro Tools or Media Station|PT client 
within an Avid Media-Network system. The Me-
diaNetwork installations addressed in this guide 
typically comprise the following components:

MediaNetwork System Entire set of components 
within an individual MediaNetwork installa-
tion.

MEDIASwitch One or more central routers di-
recting communication between different com-
ponents within a MediaNetwork system.

PortServer or PortServer Pro (Optional) One or 
more servers that let Avid workstations access 
MediaNetwork workspaces through an Ethernet 
connection (without a Fibre Channel connec-
tion).

Avid Unity Transfer Engine (Optional) Server that 
lets Avid editing applications package elements 
of an Avid sequence and transfer them to other 
locations.

File Manager One or more servers (including a 
backup server) that functions as the heart of the 
Unity MediaNetwork file system by maintaining 
location information for media stored on drives.

JBOD/IBOD Chassis that contains the drives that 
store the actual data.

Avid Interplay Transcode and/or Avid DMS ProEn-
code (Optional) Engine that distributes proces-
sor-intensive tasks to network servers in order to 
allow MediaNetwork clients (such as Avid and 
Pro Tools workstations) to proceed without in-
terruption.

Avid Interplay Access or Avid Unity MediaManager 
(Optional) Media asset management client appli-
cation that enables facility-wide searching, sort-
ing, cataloging, management, and retrieval of 
media.

Avid Interplay Assist or Avid Unity MediaManager 
Select (Optional) Client that allows real-time 
logging and annotating of any media right at 
the desktop.

Avid Interplay Engine or Avid Unity MediaManager 
Server (Optional) Server that manages the meta-
data stored on the File Manager server.

Clients One or more Avid, Pro Tools, or 
Media Station|PT workstations configured to be 
able to exchange data with other clients at-
tached to the MediaNetwork system.

Avid Unity MediaNetwork system (solid lines represent 
physical connections, while dotted lines represent 
connections through the switch)
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AAF, OMF, and MXF Basics
AAF and OMF files are mechanisms for storing 
and retrieving media data and metadata so that 
projects can be freely exchanged between differ-
ent applications and platforms (such as between 
Pro Tools and Avid video editing applications).

Media data and metadata enable an application 
that receives AAF and OMF sequence files to au-
tomatically and quickly reassemble the compo-
sition. A simple metaphor for this approach is 
that media data files are the pieces of a puzzle 
and metadata is the set of instructions for as-
sembling the puzzle.

In the simplest case, only an AAF or OMF se-
quence is exchanged. If this sequence points to 
existing media files, the size of the sequence file 
is relatively small and the export/import process 
is relatively fast. 

AAF and OMF sequences can also have media 
data embedded in them. This creates a single, 
larger file that is slower to export and import, 
but which may be easier to manage than thou-
sands of files stored on different volumes. 

Pro Tools supports AAF and OMF sequences that 
contain embedded audio media. 

Pro Tools with DigiTranslator does not support 
AAF or OMF sequences containing embedded 
video media, except if you are importing such 
sequences into a video satellite track. In such 
cases, video metadata is imported into the track.

MXF

MXF is a media file format. There are MXF video 
files and MXF audio files, but there are no “MXF 
sequences.” An AAF sequence may refer to or in-
clude MXF media files, but OMF sequences can-
not refer to or include MXF files.

Avid Support for MXF Media

Avid editing applications support MXF media as 
follows:

• Creation of MXF media when capturing, 
transcoding, rendering, or using other meth-
ods to create media

• Import of MXF media files created in other 
Avid applications

• Export of MXF audio and video files

Pro Tools Support for MXF Media

Pro Tools supports MXF media as follows:

• Import of MXF video and audio media

• Export of MXF audio media

Pro Tools cannot export video files of any type.

Video files digitized in Pro Tools are technically 
of the MXF format, but are intended only for use 
in Pro Tools and are not tested for compatibility 
with other applications.

AAF

AAF sequences are the best way to exchange 
projects and maintain valuable metadata. An 
AAF sequence can refer to OMF and/or MXF me-
dia files, or have OMF and MXF media files em-
bedded within them. There is no such thing as 
an AAF audio or video media file. 
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Avid Application Support for AAF 
Sequences

Avid editing applications support AAF se-
quences as follows:

• Import and export of AAF sequences with em-
bedded video files (MXF or OMF) and/or au-
dio files (MXF, WAV, or AIFF)

• Import and export of AAF sequences that refer 
to external (linked) video files (MXF or OMF) 
and/or audio files (MXF, WAV, or AIFF)

Pro Tools Support for AAF Sequences

With DigiTranslator 2.0, Pro Tools supports AAF 
sequences as follows:

• Import and export of AAF sequences that con-
tain embedded or refer to external (linked) 
MXF, WAV, or AIFF audio files 

• Import of AAF sequences that refer to external 
(linked) MXF or OMF video files

• Video satellite systems only: Import of AAF se-
quences containing embedded video to a sat-
ellite track, in which case Pro Tools imports 
only the metadata (cuts and clip names) and 
not the video

Pro Tools does not export video files, tracks or 
metadata as part of AAF sequences.

OMF

OMF is both a media file and sequence format. 
OMF media files can be audio or video.

Avid Application Support for OMF Media 
and Sequences

Avid editing applications support OMF media 
and sequences as follows:

• Import and export of OMF sequences with 
embedded OMF video files and WAV or AIFF 
audio files

• Import and export of OMF sequences that re-
fer to external (linked) OMF video files and 
WAV or AIFF audio files

Pro Tools Support for OMF Media and 
Sequences

With DigiTranslator 2.0, Pro Tools supports 
OMF media and sequences as follows:

• Import of OMF video files created by 
Media Station|PT or other Avid applications

• Export of OMF audio files

• Import and playback of OMF sequences that 
refer to external (linked) audio files or contain 
embedded audio files

• Import and playback of OMF sequences that 
refer to external (linked) OMF video files

• Export of OMF sequences that refer to exter-
nal (linked) audio files or contain embedded 
audio files

• Video satellite systems only: Import of OMF 
sequences containing embedded video to a 
satellite track, in which case Pro Tools imports 
only the metadata (cuts and clip names) and 
not the video

Pro Tools does not export video files, tracks or 
metadata as part of OMF sequences.



Chapter 1: Introduction 5

Embedded Media

Exporting to OMF or AAF with embedded media 
results in one large OMF or AAF file containing 
both the metadata and all associated media files. 
However, it is important to note that file size is 
limited to 2 GB.

Media Data (Media Files)

Media data represents raw audio or video mate-
rial and is stored in individual media files. Every 
time you record a piece of video or audio mate-
rial into an application, you are creating a media 
file containing media data. Audio media data is 
stored as samples (such as 44,100 or 48,000 sam-
ples per second of recording) while video media 
is typically stored as frames (24, 25, or 30 frames 
per second of recording).

The size of each media file depends on how 
much audio or video material it contains. For 
example, if you record ten minutes of continu-
ous video material at a high resolution, you 
might end up with a video media file that is 
1.8 GB in size, whereas a one minute recording 
at the same resolution might result in a 180 MB 
file. Media files tend to be large, since high qual-
ity audio and video signals are data intensive. 
Video data generally requires considerably more 
storage than audio data.

MXF Media Data Locations On the volumes you 
have designated for media storage, Avid editing 
applications store all MXF media:

• When stored locally, MXF media is placed in 
the Avid MediaFiles/MXF/1 folder. The Avid ed-
iting application can also read MXF media lo-
cated at Avid MediaFiles/MXF/2, Avid 
MediaFiles/MXF/3, and so on.

• When stored in a shared environment, MXF 
media is placed in a folder called 
Avid MediaFiles/MXF/client.1 (where client rep-
resents the name of the client computer).

This guide refers to the root folder name (Avid 
MediaFiles) whenever referencing this folder.

OMF Media Data Locations On the volumes you 
have designated, Avid editing applications store 
all OMF media in the OMFI MediaFiles folder.

Metadata

Metadata is used to describe:

• Information about each media file. This 
may include sample rate, bit depth, region 
names, the name of the videotape from 
which the media file was captured, and 
even time code values that specify where a 
file was used in a Pro Tools session.

• Information about Pro Tools sessions or 
other sequences, including what files are 
used, where they appear in a Timeline, and 
automation.

• For AAF or OMF sequences, metadata also 
includes information about unrendered 
AudioSuite effects (such as real-time EQ) on 
Avid workstations. Pro Tools skips unren-
dered effects on import. Rendered effects 
are media files, that can be imported or 
skipped on import into Pro Tools.

• For AAF or OMF sequences, information 
about automation (clip-based gain or key-
frame gain).
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Embedded Media and Linked 
Media
There are two ways to handle media files when 
exporting AAF or OMF files: 

• Embedded media (in which the media files are 
embedded in an AAF or OMF sequence)

• Linked media (in which media files are refer-
enced by an AAF or OMF sequence)

Pro Tools with DigiTranslator 2.0 lets you im-
port AAF or OMF sequences containing embed-
ded audio files. You can also import AAF or OMF 
sequences containing embedded video files, but 
only if you are importing them to a video satel-
lite track. In such a case, only the video meta-
data is imported.

Frame-Rate Accurate Video 
Editing and Sample-Rate 
Accurate Audio Editing
Avid applications edit with frame accuracy. This 
means that in a 30-fps project, you can edit at 30 
different locations for every one second of 
video. Pro Tools edits with sample rate accuracy. 
In a 48-kHz session, there are potentially 48000 
locations to edit for every second of audio. 

When Pro Tools exports an AAF or OMF compo-
sition destined for an Avid application, it must 
ensure that the audio files line up on frame 
boundaries. To do this, it might have to split an 
existing audio region into three separate re-
gions. For example, the following illustration 
shows a 5-frame video clip and a corresponding 
audio region. In Pro Tools, the audio regions 
might not line up on video frame boundaries.

In order to export frame accurate audio regions, 
Pro Tools splits the audio media on frame 
boundaries and fills any gaps with silence. The 
following illustration shows the resulting audio 
regions that are exported to Avid.

When you use Export Selected Tracks as 
OMF/AFF to export tracks from Pro Tools with 
Enforce Avid Compatibility enabled, a number 
of additional media files labeled Sample Accu-
rate Edit appear in the Avid bins. These are the 
additional media files that Pro Tools creates to 
ensure that the Avid editing application receives 
frame-accurate audio. You also see the sample-
accurate edit media files if you zoom in on the 
imported audio in the Timeline.
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Figure 1.  Original audio region

One Pro Tools audio region

5 frame video clip

The original audio region does not line up on video frame boundaries

Figure 2.  Exported audio region

Three exported audio regions

5 frame video clip

Exported audio regions line up on video frame boundaries

New audio region padded 
with silence

New audio region padded 
with silence
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System Requirements
Using Pro Tools or Media Station|PT within a 
Unity MediaNetwork system requires the 
following;

• Windows XP

• Pro Tools HD

• An available expansion slot for a Fibre Chan-
nel host bus adapter (HBA), and Fibre Chan-
nel connectivity to the Avid Unity 
MediaNetwork server

• MediaNetwork client installation software

For complete system requirements, visit the 
Digidesign website (www.digidesign.com) and 
the Avid website (www.avid.com).

Compatibility Information

Digidesign and Avid can only assure compatibil-
ity and provide support for hardware and soft-
ware they have tested and approved.

For a list of Digidesign-qualified computers, op-
erating systems, hard drives, and third-party de-
vices, visit the Digidesign website
(www.digidesign.com). 

For a list of Avid-qualified computers, operating 
systems, hard drives, and third-party devices, 
visit the Avid website (www.avid.com).

About Avid Unity 
MediaNetwork Guides
PDF versions of Avid Read Mes are installed au-
tomatically with Avid Unity MediaNetwork soft-
ware. Also, searchable online help files contain-
ing the same information are accessible from 
the Help menus in the Interplay Access and In-
terplay Administrator applications.

You can use any of the following guides as sup-
plementary information for this guide.

• Avid Unity MediaNetwork Site Preparation Guide 
contains information that helps you prepare 
your site for installing MediaNetwork system 
hardware.

• Avid Unity MediaNetwork Management Guide 
provides information for the setup and day-
to-day management of an Avid Unity Media-
Network system and system. 

• Avid Unity MediaNetwork Windows Fibre Chan-
nel Client Setup Guide provides information for 
setting up MediaNetwork client hardware, in-
stalling and configuring MediaNetwork client 
software, and creating a network of MediaNet-
work clients and other systems.

These guides and other Interplay guides are 
available on the Avid Interplay Online Library 
DVD and on the Avid Knowledge Base 
(www.avid.com/onlinesupport). To view or 
print PDF guides, use Adobe Acrobat Reader.
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Related Information

The following documents located on the Docu-
mentation disc provide more information about 
configuring and managing your work environ-
ment:

• Avid Unity MediaNetwork File Manager Setup 
Guide

• Avid Unity MediaNetwork Release Notes

• Avid Unity MediaNetwork Upgrade Notes

• Avid Unity MediaNetwork System Overview

• MediaNetwork Windows Fibre Channel Client 
Quick Start Card

• Avid Unity MediaNetwork Windows Ethernet Cli-
ent Setup Guide

• MediaNetwork Windows Ethernet Client Quick 
Start Card

• Avid Unity MediaNetwork Port Server Setup Guide

• Avid Unity MediaNetwork 3.6 Supported Configu-
rations

• Avid Unity MediaNetwork File Manager Failover 
Installation Notes

• Avid Unity LANserver EX Setup Guide

• Avid Unity LANserver Upgrade Notes

• Avid Unity LANserver Release Notes

About the Pro Tools Avid Interplay 
Guide

The Pro Tools Avid Interplay Guide describes how 
to set up Pro Tools as a client within an Avid In-
terplay system, as well as use Pro Tools and In-
terplay to exchange sequences between Avid 
and Pro Tools users.

Support for Avid Unity 
MediaNetwork
For support on Avid Unity MediaNetwork, visit 
Avid’s online Knowledge Base 
(www.avid.com/onlinesupport). Online services 
are available 24 hours per day, 7 days per week. 
Search this online Knowledge Base to find an-
swers, to view error messages, to access trouble-
shooting tips, to download updates, and to read 
or join online message-board discussions.

For support on Pro Tools HD, see “About 
www.digidesign.com” on page 10.
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Conventions Used in This 
Guide
All Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:
:

The following symbols are used to highlight im-
portant information:

About www.digidesign.com
The Digidesign website (www.digidesign.com) is 
your best online source for information to help 
you get the most out of your Pro Tools systems. 
The following are just a few of the services and 
features available. 

Support Contact Digidesign Technical Support 
or Customer Service; download software up-
dates and the latest online manuals; browse the 
compatibility information for system require-
ments; search the online Answerbase or join the 
worldwide Pro Tools community on the Digide-
sign User Conference.

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Digidesign 
products; download demo software or learn 
about our Development Partners and their plug-
ins, applications, and hardware. 

News and Events Get the latest news from 
Digidesign or sign up for a Pro Tools demo.

To learn more about these and other resources 
available from Digidesign, visit the Digidesign 
website (www.digidesign.com). 

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control 
key and press the N key

Control-click Hold down the Control 
key and click the mouse 
button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your Pro Tools session data or 
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide or other Pro Tools Guides.
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chapter 2

Configuring a Workstation as a 
MediaNetwork Client

This chapter is for Unity administrators and de-
scribes how to install and configure individual 
Pro Tools or Media Station|PT workstations as 
clients of an Avid Unity MediaNetwork system.

Installation Overview
Installing the hardware and software involves 
the following process:

1  Make sure the software (Media Station|PT or 
Pro Tools) is installed on the workstation.

2  Install the MediaNetwork client hardware.

3  Install the MediaNetwork client software.
.

Installing Media Station|PT or 
Pro Tools
If you are configuring a Media Station|PT work-
station as a MediaNetwork client, ensure that 
Media Station|PT and any optional hardware 
(such as Avid video peripherals) have been prop-
erly installed. For detailed information, see the 
Media Station|PT Guide.

If you plan to configure a Pro Tools workstation 
as a MediaNetwork client, ensure that Pro Tools 
hardware and software are properly installed. 
For detailed information, see the Pro Tools HD 
Getting Started Guide.

Installing MediaNetwork 
Client Hardware
The Avid Unity MediaNetwork client hardware 
consists of:

• One optical SFP (for the Server switch)

• One of the following qualified Fibre Channel 
HBA (Host Bus Adapter) cards:

• ATTO FC 3300 2 GB HBA

• ATTO Celerity FC-41XS 4 GB HBA

• ATTO Celerity FC-41ES 4 GB HBA 

When you update the client software, en-
sure that you update the Fibre Channel 
HBA drivers and firmware to the versions 
supported with your current version of Medi-
aNetwork.
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You will need to purchase optical cables sepa-
rately. 

To install the Fibre Channel HBA in a client 
workstation:

1  Shut down and power off your computer and 
expansion chassis (if one is present). 

2  Open your computer according to the instruc-
tions included with it. 

3  Release any static electricity by touching the 
power supply, or another grounded item.

4  Remove the Fibre Channel HBA from the an-
tistatic bag, being careful to handle it only by 
the edges.

5  Determine the correct PCI/PCIe card slot order 
(see Appendix A, “PCI and PCIe Slot Configura-
tions for Avid Video Peripherals”).

6  Line up the Fibre Channel HBA with the in-
stallation slot, and slide the card into place gen-
tly so the PCI/PCIe connector is aligned with the 
correct PCI/PCIe slot.

7  Press down firmly on the card with even pres-
sure. The connector should click into place in 
the PCI/PCIe slot.

8  To attach the card bracket to the computer 
mounting bracket, fasten the card in place using 
a screw or latch down the securing bracket if one 
is built in.

To connect a Fibre Channel optical cable to the 
Fibre Channel HBA:

1  Locate the optical cable with the LC optical 
cable connector (dual plug) on the end.

2  Remove the protective covers from the follow-
ing:

• LC optical connector on the optical cable

• Fibre Channel HBA in your computer

3  Plug the optical cable connector into the Fibre 
Channel HBA. The connector and the Fibre 
Channel HBA are keyed and only fit together 
one way. You should hear a click when the cable 
is properly seated.

For a complete, current list of qualified 
host bus adapters please consult Avid 
support.

The cable needs LC optical cable connectors 
at both ends. 

If a Fibre Channel HBA has ever been in-
stalled on your Windows system, you 
must remove any unused ATTO .INF files 
before installing the ATTO Fibre Channel 
HBA. If you do not know how to do this, 
please contact your Windows system ad-
ministrator.

Do not try to force the LC optical cable con-
nector into the Fibre Channel HBA connec-
tor. There should be no resistance as you 
make the connection. If you feel that the op-
tical cable connector does not fit into the Fi-
bre Channel HBA connector, turn the opti-
cal cable connector 180 degrees and try to 
insert the optical cable connector into the 
Fibre Channel HBA connector again.

Connecting the optical cable to the Fibre Channel HBA

LC optical connector
optical cable

Fibre Channel HBA Green and Yellow LEDs
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4  If the other end of the cable is not yet con-
nected to the MEDIASwitch, do so now. For de-
tailed instructions, see the Avid Unity 
MediaNetwork Configuration Guide and the Avid 
Unity MediaNetwork Site Preparation Guide.

Fibre Channel HBA LED States

The LEDs on the Fibre Channel HBA indicate 
whether or not the card is functioning correctly. 
See Table 1 for the 2 Gb Fibre Channel HBA or 
Table 2 for 4 GB Fibre Channel HBAs.

Table 1. ATTO FC 3300 2 Gb Fibre Channel HBA LED states

LED LED State Meaning Required Action

Green On Normal—link up No action required

Yellow On Link down Check cable connec-
tion to MEDIASwitch 
and Fibre Channel 
HBA. If condition per-
sists, contact Avid 
customer support.

Yellow Flashing Fault Contact Avid customer 
support.

Green or Yellow Off Driver not loaded Load driver. If condi-
tion persists, contact 
Avid customer sup-
port.

Table 2. ATTO Celerity FC-41ES and FC-41XS 4 Gb Fibre Channel HBA LED states

LED LED State Meaning

Link Green Indicates that a supported hardware driver is loaded for the ATTO Celerity 
card in its host system, and that another hardware device is detected at 
the other end of the connected fibre cable.

2 GB Green Indicates that the HBA is running in 2Gb mode.

4 GB Amber or Green Indicates that the HBA is running in 4Gb mode.
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Installing MediaNetwork 
Client Software
The MediaNetwork client software lets the Win-
dows XP Fibre Channel-equipped client log in to 
the MediaNetwork File Manager and to map ac-
cessible workspaces. The client software is sup-
plied on the MediaNetwork Release CD-ROM in 
the Windows client kit.

Installing MediaNetwork client software in-
volves the following steps:

1  Uninstall any existing previous version of the 
MediaNetwork client.

2  Install the Fibre Channel Controller driver.

3  Install the MediaNetwork client software.

Uninstalling a Previous Version of 
the MediaNetwork Client

If you are upgrading to a new version of Media-
Network client software, you must first uninstall 
the previous version.

To uninstall the previous version of MediaNetwork 
client software:

1  Choose Start > Control Panel.

2  Launch Add or Remove Programs.

3  From the Currently Installed Programs list, se-
lect the Avid Unity application.

4  Click the Change/Remove button.

5  Follow the on-screen instructions to remove 
the MediaNetwork client software.

Installing the Fibre Channel 
Controller Driver

Before installing the MediaNetwork Client soft-
ware, you must install the Fibre Channel Con-
troller driver. The first time you start Windows 
after installing the Fibre Channel HBA, the 
Found New Hardware Setup Wizard will prompt 
you to locate and install the driver for the Fibre 
Channel Controller.

To install the Fibre Channel Controller driver:

1  Turn on your computer.

2  Log into Windows with Administrator privi-
leges. If you do not have Administrator privi-
leges or do not know how to set them up, see 
your Windows documentation.

3  Wait for the Found New Hardware Wizard di-
alog to appear and leave it open.

4  Insert the MediaNetwork Release software CD-
ROM into your computer’s CD-ROM drive. The 
Found New Hardware Wizard will locate and in-
stall the Fibre Channel Controller driver.

5  If installing an ATTO HBA that requires a 
phantom driver, eject the MediaNetwork Re-
lease software CD-ROM when the Found New 
Hardware Wizard prompts you for the ATTO 
Phantom Device.

6  If installing an ATTO HBA that requires a 
phantom driver, re-insert the MediaNetwork Re-
lease software CD-ROM and the Found New 
Hardware Wizard will locate and install the 
ATTO Phantom Device.

7  Click Finish to complete the installation and 
restart your computer.

After installing the Fibre Channel HBA driver 
and restarting your computer, proceed by in-
stalling the MediaNetwork client software.

You must have a supported version of Win-
dows XP installed before you install the 
MediaNetwork client software.
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Installing the MediaNetwork 
Client Software

To install the MediaNetwork client software:

1  Turn on your computer.

2  Log into Windows with Administrator privi-
leges. If you do not have Administrator privi-
leges, see your Windows administrator.

3  Insert the MediaNetwork Release software CD-
ROM into your computer’s CD-ROM drive.

The MediaNetwork Release software CD-ROM 
autoruns the Avid Unity Installation Main 
menu.

4  In the Avid Unity Installation Main menu, 
click Product Installers.

5  Click MediaNetwork Components.

6  Click Install Fibre Attached Client. 

Avid Unity Installation Main Menu

Avid Unity Installation (screen 2)

Avid Unity Installation (screen 3)
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7  In the InstallShield Wizard, follow the on-
screen instructions to proceed with installation.

8  At the end of the installation, select “Yes, I 
want to restart my computer now.”

9  Click Finish to complete the installation and 
restart your computer.

10  When Windows finishes restarting, the 
Found New Hardware Setup Wizard prompts 
you for the AvidComm Fake Comm Disk SCSI 
Processor Device.

11  Insert the MediaNetwork Release software 
CD-ROM into your computer’s CD-ROM drive.

12  Follow the on-screen instructions.

13  When prompted, click Finish to complete 
the installation.

After completing the installation, verify that 
your computer’s date and time settings are cor-
rect.

Setting the Date and Time

You need to correctly set the date, time, time 
zone, and daylight savings time on your com-
puter to be able to use the Synchronize Time 
with Server function for your MediaNetwork cli-
ent.

To set the date and time on Windows XP:

1  Choose Start menu > Control Panels, and 
launch the Date and Time Control Panel.

2  Click the Time Zone tab and select the correct 
time zone.

3  Make sure that “Automatically adjust clock for 
daylight savings changes” is selected.

4  Click the Date & Time tab and set the Current 
Date and Current Time.

5  Click OK to save your changes, then close the 
Date and Time Control Panel.

Avid Unity Installation (screen 3)
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chapter 3

Using a Client in a MediaNetwork System

This chapter describes how to use MediaNet-
work client software to configure your Pro Tools 
or Media Station|PT workstation as a MediaNet-
work client, as well as set up and work with 
Pro Tools or Media Station|PT in a MediaNet-
work system.

Getting Started Using a 
Workstation as a 
MediaNetwork Client

To get started using your workstation as a 
MediaNetwork client, follow these steps:

1  Log into MediaNetwork: See “Logging into a 
MediaNetwork System” on page 17.

2  Assign the workspace drive letter: See “Assign-
ing the Workspace Drive Letter” on page 18.

3  Mount a workspace on your Pro Tools client: 
See “Mounting and Unmounting Workspaces” 
on page 19.

Logging into a MediaNetwork 
System
After installing MediaNetwork hardware and cli-
ent software to your workstation, you must log 
into the MediaNetwork system in order to con-
figure and mount MediaNetwork drives.

To log into the MediaNetwork system:

1  Click the MediaNetwork taskbar icon, and 
choose Change User from the pop-up menu.

MediaNetwork administrators should pro-
vide users of each Pro Tools client with an 
individual username and password. If you 
do not have a password, contact your ad-
ministrator.

MediaNetwork taskbar icon and pop-up menu

MediaNetwork 
taskbar icon
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2  In the Login dialog, enter your username and 
password, and click OK to login.

Assigning the Workspace 
Drive Letter
MediaNetwork workspaces (drives) are automat-
ically assigned a sequential series of alphabetical 
letters starting with the letter f. For example, a 
MediaNetwork system containing three work-
spaces would be assigned the drive letters f, g, 
and h, respectively.

If your MediaNetwork client contains any local 
drive that shares a letter (such as f) with a Unity 
workspace, you must re-map the Unity work-
spaces so that drive letters on the Pro Tools cli-
ent do not overlap with drive letters on Unity 
workspaces. 

To re-map workspace drive letters:

1  Click the MediaNetwork taskbar icon, and 
choose Configure from the pop-up menu.

2  In the Avid Ethernet Attached Client dialog, 
click Advanced.

The Advanced Connection Manager Options di-
alog appears.

3  From the “Assign Workspace Drive Letters 
Starting With” pop-up menu, select the letter to 
which the first workspace will be assigned. 
(Make sure to select a letter whose range of se-
quential letters does not include any letters as-
signed to drives on your Pro Tools client.)

4  Select “Synchronize the System Clock with 
the Server Clock.” This is necessary to help pre-
vent time-related title creation and access prob-
lems by synchronizing the time of the 
MediaNetwork client to the time of MediaNet-
work File Manager.

Login dialog

Avid Ethernet Advanced Client Configuration dialog

Advanced Connection Manager Options dialog

Advanced
button
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5  If you want to be notified when the status of a 
workspace connection is lost, select the relevant 
option.

6  Click OK to apply changes.

Mounting and Unmounting 
Workspaces
Mounting a workspace to your Pro Tools or 
Media Station|PT workstation is equivalent to 
connecting to a network drive or mounting a 
FireWire drive to your computer. Once the drive 
is mounted, you can connect to that workspace, 
stream media from it, save media to it, and un-
mount it.

To mount or unmount Unity workspaces using your 
Pro Tools client:

1  Click the MediaNetwork taskbar icon, and 
choose Manage Connections from the pop-up 
menu.

2  In the Avid Unity Connection Manager dia-
log, select the Workspaces that you wish to 
mount or unmount.

3  If mounting a workspace, and you want the 
Pro Tools client to automatically mount these 
workspaces each time you log into the Media-
Network system, select the option at the bottom 
of the dialog.

4  Click Apply.

Changing the User
Different users can use the same Pro Tools client 
to work on different projects with different Me-
diaNetwork workspace permissions.

To log out and log in as a different user on 
MediaNetwork:

1  If Pro Tools is running, quit Pro Tools.

2  Click the MediaNetwork taskbar icon, and 
choose Manage Connections from the pop-up 
menu.

3  In the Avid Connection Manager, choose 
Change User.

4  In the Login dialog, enter your user name and 
password.

5  Click OK.

The previous user will be logged out of Medi-
aNetwork, and you will be logged in to Medi-
aNetwork as a new user. Use Manage Connec-
tions to mount MediaNetwork workspaces.

Avid Unity Connection Manager dialog
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Configuring the Pro Tools|HD 
Playback Engine
Pro Tools|HD workstations have multiple play-
back modes at different sample rates. For opti-
mum performance in a MediaNetwork system, it 
is recommended that you use the least number 
of voices per DSP. 

To configure the Playback Engine:

1  Launch Pro Tools.

2  Choose Setups > Playback Engine. 

3  Select the lowest number of voices per DSP for 
the Playback Engine.

4  Click OK.

Configuring Pro Tools Session 
Settings for a New Session
The following describes the recommended ses-
sion settings for creating a new Pro Tools session 
when working in a MediaNetwork system.

To create a new Pro Tools session for Avid Unity 
MediaNetwork:

1  In Pro Tools, choose File > New Session.

2  In the New Session dialog, select an Audio File 
Type for the session that is compatible across all 
workstations.

3  Select a Sample Rate for the session that is 
compatible across all workstations.

4  Select a Bit Depth for the session that is com-
patible across all workstations.

5  Name the session and save it to an Avid Unity 
MediaNetwork workspace.

Playback Engine dialog for Pro Tools|HD

You can use the other Playback Engine set-
tings if your session is on local storage. 

New Session dialog
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Audio File Type

Pro Tools supports AIFF and BWF (.WAV) audio 
files natively. 

For the best media compatibility between 
Pro Tools workstations and Avid workstations, 
you should choose to work with Broadcast WAV 
media files. Make sure the Audio File Type pop-
up menu in the New Session dialog box is set to 
WAV when you are creating a new session.

Sample Rate

Pro Tools HD supports sample rates up to 
192 kHz, but other Pro Tools and Avid worksta-
tions only support lower sample rates. There-
fore, when working in mixed MediaNetwork 
systems, it is vital to use sample rates for shared 
media that are supported on all workstations.

It is preferable for all participants in the system 
to agree on a standard, universal sample rate for 
the sake of compatibility and to avoid media 
conversion. Many facilities choose 48 kHz, 
which is the industry standard for post produc-
tion and broadcast applications. 

Bit Depth

Some older Avid workstations support only 
16-bit audio. Make sure you consider the follow-
ing when you are starting a new audio session:

• For maximum compatibility when using a 
Pro Tools workstation to share audio files and 
sequences with older Avid workstations in a 
MediaNetwork system, set the bit depth to 
16-bit in the New Session dialog box when 
you are creating new session files. 

• When using a Pro Tools workstation to share 
audio files and sequences with either 
Pro Tools workstations or current Avid work-
stations in a MediaNetwork system, set the bit 
depth to either 16-bit or 24-bit (depending on 
your project requirements) in the New Session 
dialog box when you are creating new session 
files.

All Sound Designer II files must be con-
verted to a Windows-compatible format.

The WAV file format is required when 
working with audio files containing field re-
corder metadata.

For the most current compatibility informa-
tion on supported Pro Tools systems and 
Avid Unity MediaNetwork, refer to the Avid 
website (www.avid.com) and the Digide-
sign website (www.digidesign.com).
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Performance Guidelines

Maximum Number of Clients

At the time of this writing, the following config-
urations have been thoroughly tested by Avid 
and Digidesign, and are provided only as guide-
lines. Actual performance depends on specific 
configuration and program material. More con-
figurations will be announced as they are tested. 
For the latest information of supported configu-
rations, see the Avid Unity MediaNetwork com-
patibility pages on the Digidesign website 
(www.digidesign.com).

Pro Tools Only System

Mixed Systems

Pro Tools|HD 
1000 ms Audio Edit Density
10 video and 10 audio Drives

Clients Tracks
Sample Rate/
Bit Depth

Video

1 32 48 kHz/24-bit 1:1

3 48 48 kHz/24-bit 3:1

9 24 48 kHz/24-bit 3:1

Pro Tools|24 MIX (Pro Tools TDM 5.1.3)
10 video and 10 audio Drives 
(30 audio drives are required for 9 clients)

Clients Tracks
Sample Rate/
Bit Depth

Video

1 24 48 kHz/24-bit 1:1

3 48 48 kHz/24-bit 3:1

9 32 48 kHz/24-bit 3:1

Mixed System A

Type Clients Video

Media 
Composer

4 1:1 Dual-Stream

Pro Tools 1 1:1 Single-Stream

Mixed System B

Type Clients Video

Media 
Composer

4 1:1 Dual-Stream

Pro Tools 3 3:1 Single-Stream

Mixed System C

Type Clients Video

Media 
Composer

9 3:1 Single-Stream

Pro Tools 3 3:1 Single-Stream

Mixed System D

Type Clients Video

Media 
Composer

2 10:1 Dual-Stream

6 3:1 Single-Stream

Pro Tools 3 3:1 Single-Stream
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Drive Requirements

Table 3 on page 23 shows the number of dedi-
cated drives required for the specified number of 
Pro Tools systems to play back 48 tracks of 
48 kHz, 24-bit audio at the specified edit den-
sity. The 4-, 5-, and 9-client configurations are 
only supported with 2- and 4-Gb Fibre Channel 
switches and IBODs/JBODs. These numbers are 
approximate, performance will vary depending 
on configuration and program material.

Sharing Allocation Groups and 
Media

Audio and video files can be shared among sev-
eral MediaNetwork clients. However, keep in 
mind the following restrictions when sharing 
Allocation Groups and files:

• Audio files for Pro Tools clients should be in a 
separate allocation group from the video files.

• Pro Tools clients cannot use files that are in a 
shared uncompressed allocation group.

• Each Avid video editing client that is using 
dual-stream 1:1 video must have dedicated ac-
cess to the single-user allocation group con-
taining the video files. No other clients can 
share the video files while these clients are us-
ing them.

• Only one Pro Tools client can access a finish-
ing allocation group containing 1:1 video 
files. The allocation group may not be used si-
multaneously by a video editing client, and 
the Pro Tools client can only play a single 
stream of video.

• Up to three Pro Tools clients and one video 
editing client can access an allocation group 
containing 3:1 or lower compressed video 
files.

• In an environment with at least one Avid 
Media Composer client running two streams 
at 1:1 video resolution, the maximum num-
ber of clients that can normally be supported 
is seven.

• Each finishing video allocation group must 
connect directly to a MEDIASwitch port.

Table 3. Allocation Group Sizes

Pro Tools 
Clients

Number of Drives at 
1000 ms Edit Density:

1 4

2 6

3 8

4 28

5 28

9 30
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Performance Characteristics

You should experience no functional difference 
between working with Pro Tools attached to a 
MediaNetwork system or working with 
Pro Tools attached to local storage. However, 
due to the architectural differences between Me-
diaNetwork and local storage, some subtle dif-
ferences may be noticeable.

User Interface and Graphics

The Pro Tools workstation is tasked in a com-
pletely different manner when Pro Tools is re-
cording or playing from MediaNetwork storage. 
For this reason, the update speed of the display 
and the responsiveness of the Pro Tools user in-
terface might differ somewhat when compared 
to using local storage. When using MediaNet-
work storage, the Pro Tools workstation might 
periodically be interrupted by sporadic bursts of 
communication with the File Manager. This can 
cause the display to not refresh smoothly. These 
periodic, brief interruptions in display updating 
are most prevalent during long recording ses-
sions or while playing back large sessions. These 
interruptions do not necessarily indicate that a 
problem exists and do not affect audio playback. 
Except for these interruptions or when tasks are 
in progress, display and user interface perfor-
mance should be comparable to using local stor-
age. 

For example:

• Counters, meters, scrolling, and other ani-
mated user interface elements are visually 
smooth in operation.

• Faders and panners move smoothly when au-
tomated. 

• Mouse control of faders and panners is imme-
diate and responsive. This includes TDM plu-
gins. RTAS and AudioSuite plug-ins, because 
of their host-based implementation, might 
provide less-than-smooth operation under 
certain circumstances.

• Scrubbing and auditioning (in the Regions 
List and Import Audio dialog) is immediate 
when you press the mouse button.

• Editing during playback is smooth. Mouse 
control of editing tools is immediate and re-
sponsive.

Opening Files

Pro Tools periodically opens and closes files (for 
example, to buffer them for playback). When us-
ing MediaNetwork storage, the file open process 
is somewhat slower than with local storage. This 
is most noticeable when first opening an exist-
ing session. It can also result in sluggish 
Pro Tools performance with very large sessions.
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Sharing Files

Sharing Session Files

To avoid machine conflicts among multiple us-
ers and avoid general performance problems, no 
two Pro Tools clients should open the same ses-
sion at the same time. Only one Pro Tools client 
should have a particular session open at any 
given time.

Sharing Video Files

Pro Tools clients with Avid video peripherals 
(such as Avid Mojo, Avid Mojo SDI, and AVop-
tion|V10) can share JFIF and MXF video files 
with other MediaNetwork clients. Pro Tools can-
not destructively modify video files.

Sharing Audio Files

Pro Tools clients can share audio files in an allo-
cation group with other MediaNetwork clients. 
When working with shared audio files, it is rec-
ommended that you use the Duplicate com-
mand to make a copies before applying any de-
structive edits.

MacDrive 6.0 Damages Avid Unity 
Volumes

MacDrive 6.0.6 and the Pro Tools Mac HFS+ 
Disk Support Option both support recognition 
of Avid Unity systems and do not cause the is-
sues mentioned above.

Destructive Editing
The following Pro Tools features can destruc-
tively modify audio files:

• Pencil Tool

• “Destructive” AudioSuite

• Destructive Record

• Compact Selected

• DestructivePunch Record

• DigiBase metadata entry/editing

When working with shared audio files, it is rec-
ommended that you use the Duplicate com-
mand to substitute copies before applying any 
destructive edits. This avoids the problem of 
modifying a file referenced by another session.

To substitute a copy of a shared file:

1  In Pro Tools, select the region you want to 
copy in the Edit window.

2  Choose Edit > Duplicate.

If you have a Windows XP client attached 
to Avid Unity volumes, do not install 
MacDrive 6.0. This application will prompt 
to update the Unity volumes whenever they 
are mounted. Allowing MacDrive 6.0 to up-
date them will result in complete data loss 
for the Unity volumes, and they will need to 
be rebuilt.
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MXF and OMF Files

Pro Tools treats all MXF and OMF media that are 
both created by Avid and stored on Unity shared 
storage as read-only. Consequently, destructive 
editing tools cannot be used to modify MXF and 
OMF media files. However, you can delete or 
overwrite MXF and OMF files.

Because Pro Tools creates both MXF/OMF and 
non-MXF/OMF media files, these destructive ed-
iting tools can be used on non-MXF/OMF media 
created by Pro Tools. When you are working in a 
MediaNetwork system, you should always create 
a copy of an audio file before applying a destruc-
tive change.

Use the Duplicate or Consolidate com-
mands in Pro Tools to make non-OMF cop-
ies of audio files for destructive editing.
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chapter 4

Avid Unity MediaNetwork Workflows for 
Pro Tools

This chapter covers workflows for using an Avid 
editing application (such as Media Composer or 
Media Station|PT) and Pro Tools to exchange 
AAF and OMF sequences using MediaNetwork 
shared storage, as follows:

• Exporting audio and video from 
Media Composer 2.5 and higher

• Exporting audio and video using a version of 
Media Composer prior to 2.5

• Importing audio and video into Pro Tools

• Exporting audio from Pro Tools for Avid edit-
ing applications

• Importing audio into an Avid application 
from Pro Tools

• Synchronizing audio with an Avid sequence

Exporting Audio and Video 
from Media Composer 2.5 and 
Higher
To export sequences from Avid applications 2.5 
and higher for import into Pro Tools, you can 
choose from the following methods:

• Using the Send To templates to export an 
AAF or OMF sequence

• Manually exporting an AAF or OMF se-
quence

• Exporting an AAF or OMF sequence di-
rectly to an Interplay server 
(Media Composer 2.6 or higher and Avid 
Interplay system required)

• Checking a sequence into Avid Interplay 
for Pro Tools (Media Composer 2.6 or 
higher and Avid Interplay system required)
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Using the Send To Templates to 
Export an AAF or OMF Sequence 
from Media Composer 2.5 and 
Higher

The Send To Templates option lets you create 
one AAF sequence that references audio and 
video files used in the sequence, and save it to 
the volume selected in your Avid Preferences.

To use the Send To Digidesign Pro Tools 
templates:

1  Select a sequence in a bin.

2  Choose File > Send To > Digidesign Pro Tools 
on Unity, then choose one of the following op-
tions:

Link to Audio and Video Creates an AAF se-
quence that links to existing audio and video 
wherever possible and only creates new media 
files for effects that have not been rendered. This 
is the fastest and most storage-efficient way to 
export a sequence.

Choose this option for a scenario in which 
Pro Tools will link to the same media files as the 
current Avid sequence. Use this setting if the 
media files are currently stored on volumes that 
are suitable for Pro Tools media playback.

QuickTime–Link to Audio Creates an AAF se-
quence that links to existing audio, and creates a 
new QuickTime movie. 

Choose this option when exporting a sequence 
for a Pro Tools system that does not have an 
Avid video peripheral attached.

VIdeo Mixdown–Link to Audio Creates an AAF se-
quence that links to existing audio and includes 
editing metadata as well as a video mixdown in 
the video format defined by Media Creation set-
tings. When imported into Pro Tools, the video 
mixdown and metadata are displayed in two 
separate video tracks on the Timeline.

Choose this option for any scenario in which 
Pro Tools will link to the same media files as the 
current Avid sequence.

3  If you want to view or change export settings, 
click the Options button, and then make any 
changes. If you make any changes, you can use 
the Save As Template button to create a new 
template.

4  Click Set.

5  Navigate to the location where you want the 
AAF or OMF files to reside.

6  Click OK.

Send To dialog (LInk to Audio and Video options shown)

This workflow assumes that you use the de-
fault values. This means that you are ex-
porting using the Project sample rate, audio 
file format, and sample bit depth.
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The Avid application exports the files to the des-
tination volume. If the Avid application has to 
transcode video files to a new resolution, render 
effects or perform audio file conversions, a new 
sequence appears in the bin with the name file-
name.Export.01, and a new master clip appears 
in the bin with the name filename.new.01.

Manually Exporting an AAF 
Sequence from Media 
Composer 2.5 and Higher

Manually exporting an AAF sequence from an 
Avid editing application involves more steps 
than using the Send To templates, but it pro-
vides more flexibility. 

Once all effects have been rendered, export the 
sequence as an AAF sequence.

To manually export an AAF sequence:

1  Select the sequence in the bin.

2  Select File > Export.

3  Type a name and select a location for the ex-
ported sequence.

4  Select Export to Pro Tools from the Export Set-
tings menu at the bottom of the Export As dia-
log.

5  Click the Options button to open the Export 
to Pro Tools Settings dialog. Verify the settings:

• For Export As, select AAF.

• Select the Include All Video Tracks in Se-
quence option. When the sequence is im-
ported into Pro Tools. All of the video 
tracks will be “flattened” so that the im-
ported sequence shows only a single video 
stream.

You will need to render all video effects be-
fore manually exporting the sequence.

Export As dialog

Export Settings–Export To Pro Tools dialog, Video 
Details tab
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6  In the Video Details tab, select one of the 
following from the Export Method pop-up 
menu:

Link to (Don’t Export) Media The Pro Tools ses-
sion will link to the same video files as the cur-
rent Avid sequence. Use this setting if the video 
files are currently stored on a volume suitable 
for Pro Tools video playback.

Copy All Media New complete video files will be 
created on the designated volume.

Consolidate Media Similar to Copy All Media, 
but only the parts of the video clips which are 
actually used in the Timeline are copied. Use 
this setting to copy the video files to a volume 
suitable for Pro Tools video playback.

Video Mixdown The exported AAF sequence will 
reference a video mixdown. This setting lets you 
have a choice of whether to export the video 
mixdown alone or the video mixdown along 
with additional video track edits. The choice de-
pends largely on the version of Pro Tools to 
which you are exporting. Pro Tools 7.2 and 
higher can show the video mixdown alongside 
video edits; in this case, you should select both 
the video mixdown and the video edits. For ver-
sions of Pro Tools lower than 7.2, you should ex-
port the video mixdown by itself.

The following settings may also appear under 
the Video Details tab, depending on the selected 
export method:

Media Destinations Choose where to store cop-
ied video files.

Handle Length Extends the beginning and end 
of the consolidated file by the specified number 
of frames. This lets you trim edits later, though 
the sequence would need to be re-edited in the 
Avid application.

Render Video Effects Always select Render Video 
Effects. If you already manually rendered effects, 
selecting this option will not create new files. It 
is highly recommended that all effects be ren-
dered manually before exporting the sequence.

Transcode Video To Use this only if you need to 
change the video resolution. Pro Tools supports 
most SD resolutions supported by Avid, and 
even supports mixed resolutions in the 
Pro Tools Timeline, so in most cases there is no 
need to spend extra time transcoding the video. 
However, if you have video of a resolution 
which is not currently supported by Pro Tools, 
use this setting to transcode it to a supported 
resolution. 

While new video files are typically stored in the 
OMFI MediaFiles folder (for OMF) or the Avid 
MediaFiles folder (for MXF), some workflows let 
you choose a different target destination for 
video in the Media Destination section of the 
Video Details tab, as follows:

Media Drive This option exports media to the 
OMFI MediaFiles folder or Avid MediaFiles 
folder on a connected storage drive. Select the 
Use Media Creation Settings option to use the 
default settings, or deselect that option to 
choose a media drive from the pop-up menu.

If your Pro Tools system is running on a 
slower computer, you may be able to reduce 
some of the CPU load in Pro Tools by 
transcoding the video to 1:1 on export. 1:1 
video is uncompressed, and consequently it 
does not need to be decompressed before 
playing back. However, 1:1 video requires 
significant amounts of storage space.
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Folder This option exports video media to a spe-
cific folder. Select the Use Same Folder as AAF 
File option to export the video media into the 
same folder you designated for exporting the 
AAF sequence, or deselect this option to select a 
specific folder location for the media.

Embedded in AAF This option embeds the video 
media in the AAF sequence that is exported from 
the Avid application. 

7  Click the Audio Details tab, and select one of 
the following from the Export Method pop-up 
menu:

Link to (Don’t Export) Media The Pro Tools ses-
sion will link to the same audio files as the cur-
rent Avid sequence. Use this setting if the audio 
files are currently stored on a volume suitable 
for Pro Tools audio playback.

Copy Media New complete audio files will be 
created on the designated volume.

Consolidate Media Similar to Copy All Media, 
but only the parts of the audio which are actu-
ally used in the Timeline are copied. Use this set-
ting to copy the audio files to a volume suitable 
for Pro Tools audio playback.

The following settings may also appear under 
the Audio Details tab, depending on the selected 
export method:

Render All Audio Effects Select the Render All 
Audio Effects option so that all audio effects are 
rendered before export. If you already manually 
rendered effects, selecting this option will not 
create new files. It is highly recommended that 
all effects be rendered before exporting the se-
quence.

Include Rendered Audio Effects Select the In-
clude Rendered Audio Effects option. Otherwise, 
the exported sequence will include the original 
audio files without any AudioSuite effects from 
the original sequence—even if those effects were 
previously rendered.

Convert Audio Sample Rate/Bit Depth/File For-
mat Select Project for any of these, and the cur-
rent Audio Project Setting will be used.

While new audio files are typically stored in the 
OMFI MediaFiles folder (for OMF) or the Avid 
MediaFiles folder (for MXF), some workflows let 
you choose a different target destination for au-
dio in the Media Destination section of the Au-
dio Details tab, as follows:

Media Drive This option exports audio media to 
the OMFI or Avid MediaFiles folder on con-
nected storage. Select the Use Media Creation 
Settings option to use the default settings, or de-
select that option to choose a media drive from 
the pop-up menu.

Folder This option exports audio media to a spe-
cific folder. Select the Use Same Folder as AAF 
File option to export the media into the same 
folder you designated for exporting the AAF se-
quence, or deselect this option to select a spe-
cific folder location for the media.

Pro Tools cannot play video that is embed-
ded in an AAF sequence, but it can read the 
video editing metadata when imported into 
a satellite track. Do not use this option if 
you want to import the video itself into 
Pro Tools.

Media Destination section of the Video Details tab
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Embedded in AAF This option embeds the audio 
media in the AAF sequence that is exported from 
the Avid application. Unlike embedded video, 
Pro Tools can import and play audio which is 
embedded in an AAF sequence. Embedding au-
dio within the AAF sequence makes file manage-
ment much simpler because there is only one 
file to move—the sequence. There is a limit of 
2 GB for embedded AAF.

8  Click Save or Save As in the Export Settings di-
alog:

• Click Save to use the specified settings 
whenever Export to Pro Tools is selected 
from the Export Settings menu. These set-
tings will also be used when choosing any 
of the options located at File > Send To > 
Digidesign Pro Tools to Unity. 

• Click Save As to save these settings as a pre-
set with a different name. These settings 
can then be recalled in the Export dialog. If 
you click Save As instead of Save, the Ex-
port to Pro Tools settings will not be 
changed.

9  Click Save in the Export As dialog. (The Export 
Settings cannot be saved until you have selected 
a target drive for both audio and video.)

When the export is complete, you are ready to 
import the file into Pro Tools.

To export only part of a sequence:

1  Choose Clip > New Sequence to create a new 
sequence.

2  In the bin, name the sequence and drag it to 
the Record Monitor.

3  Drag your original sequence to the Source 
Monitor.

Pro Tools cannot play video that is embed-
ded in an AAF sequence, but it can read the 
video editing metadata when imported into 
a satellite track. Do not use this option if 
you want to import the video itself into 
Pro Tools. 

For more information on opening and im-
porting AAF sequences in Pro Tools, see 
“Importing Audio and Video into 
Pro Tools” on page 43. For more informa-
tion on the Import Session dialog, see the 
Pro Tools Reference Guide.

Avid Media Composer main window
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4  Use the controls underneath the Source Mon-
itor to locate the first frame of the portion of the 
clip that you want to edit into the sequence:

• To begin playing the clip, click Play (or 
press the Spacebar). Click Play or press the 
Spacebar again to Pause.

• To move to the beginning of the clip, click 
Rewind (or press the Home key).

• To move to the end of the clip, click Fast-
Forward (or press the End key).

• To nudge by frame, click Step Forward 1 
Frame or Step Backward 1 Frame (or press 
the Left/Right Arrow keys).

• To scrub, click and drag the cursor beneath 
the Source Monitor. (Enable the Caps Lock 
to hear audio while scrubbing.)

5  Click Mark In to mark the In point (the first 
frame of the selected portion of the clip) at the 
current position of the cursor.

6  Using the same controls, locate the last frame 
of the portion of the clip that you want to edit 
into the sequence. 

7  Click Mark Out to mark the Out point (the last 
frame of the selected portion of the clip) at the 
current position of the cursor.

8  Click the Record Monitor to select the empty 
sequence, then press the Home key to move the 
cursor to the beginning of the sequence.

9  Click the Overwrite or Splice-In button. The 
selected portion of old sequence is edited into 
the empty sequence in the Record Monitor.

10  Follow the preceding steps for exporting the 
new sequence (see “Manually Exporting an AAF 
Sequence from Media Composer 2.5 and 
Higher” on page 29).

Source Monitor controls

Rewind

Fast-
Forward

Step Forward 1 
Frame

Cursor

Play/ 
Pause

Step Backward 1 
Frame

Mark 
Out

Mark 
In

Clear Both 
Marks

Mark 
Clip

You can also select the entire clip by clicking 
Mark Clip.

Overwrite and Splice-In buttons

OverwriteSplice-In
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Checking In a Sequence to 
Interplay for Pro Tools 

(Media Composer 2.6 or Higher with Avid Inter-
play System Only)

This section describes how to use an Avid appli-
cation (such as Media Composer 2.6 or higher) 
to check in a sequence to Interplay for 
Pro Tools.

To check in a sequence to Interplay for Pro Tools:

1  In the Avid application, navigate to the bin 
containing the sequence you want to export.

2  Do one of the following:

• Select the sequence, and choose File > 
Check In to Interplay for Pro Tools.

– or –

• Right-click the sequence, and choose 
Check In to Interplay for Pro Tools.

If you have previously set the Editor Export Set-
tings for Pro Tools for the folder, the Pro Tools 
Video Mixdown dialog appears.

3  Select one of the following options:

New Video Mixdown Includes a video mixdown 
in the exported sequence using the resolution 
set in the Project Type pop-up menu of the 
project window’s Format tab. Select this option 
if you are working on an HD project. No video 
effects will be rendered in the project.

Bin containing the sequence to export

Video Mix dialog

See the Pro Tools Avid Interplay Guide for 
detailed information.
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Link to Existing Video Media Use this option 
when effects have either been rendered or are 
unnecessary for working in Pro Tools. (Ensure 
that linked video can be played from the 
Pro Tools system.) With this option, the Avid 
application:

• Does not render any effects.

• Determines whether the current resolution 
matches the Transcode resolution in the Edi-
tor Export Settings for Pro Tools plug-in in the 
Interplay Administrator. Depending on 
whether the settings match, one of the follow-
ing occurs:

• If the settings either match or have not 
been created for the check-in folder, the 
system creates a sequence that links to the 
existing media and does not create a video 
mixdown or render any video effects.

• If the settings do not match, the system 
transcodes the sequence according to the 
setting in the Export Settings for Pro Tools 
plug-in and links the sequence to this new 
media. The system also renders (or re-ren-
ders) all video effects to match the 
transcode resolution. The application over-
rides the “Link To” option in order to guar-
antee that you have access to a resolution 
supported by Pro Tools.

4  Click OK to check in the sequence to Interplay 
for Pro Tools.

After Checking In a Sequence to 
Interplay for Pro Tools

The system exports the sequence from the Avid 
application, and then checks in the sequence to 
Interplay.

If the Interplay folder containing the exported 
sequence has been configured with video and 
audio settings defined in the Editor Export Set-
tings for Pro Tools plug-in, those settings are ap-
plied to the sequence. (These settings can apply 
to either the entire database or to one or more 
folders, depending on how they are configured.)

When you use an Avid application to check in a 
sequence to Interplay for Pro Tools, the system 
chooses a destination folder in the Interplay da-
tabase based on the current Interplay view set-
tings, with the default destination folder as fol-
lows:

Projects\project_name\bin_name

If your check-in destination folder is a folder for 
which settings have not been defined, the sys-
tem displays the Pro Tools Export Settings dia-
log so you can specify the settings. 

Pro Tools Export Settings dialog
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Exported Files in Interplay

If this is the first time the you have checked in a 
sequence to Interplay for Pro Tools for this 
project, the system performs the following oper-
ations:

• Checks in the Avid sequence to the bin_name 
folder.

• Creates a Pro Tools folder within the bin_name 
folder.

• Checks in the files for the Pro Tools editor to 
the Pro Tools folder.

• Checks in a Pro Tools sequence to the 
Pro Tools folder.

The first time the sequence is exported, the sys-
tem appends the text “_v1_forPT” to the se-
quence name in the Pro Tools folder. Each sub-
sequent time the sequence is exported, it uses 
the text “_v2_forPT,” “_v3_forPT,” and so on.

The following illustration shows the contents of 
the Pro Tools folder after the first export.

Exporting Audio and Video 
using a Version of Media 
Composer Prior to 2.5
To export sequences from versions of Avid ap-
plications (such as Media Composer) prior to 2.5 
for import into Pro Tools, you can choose from 
the following methods:

• Using the Send To templates to export an AAF 
or OMF sequence

• Manually exporting an AAF or OMF sequence

• Creating a video mixdown

Location of the Avid sequence and its associated 
Pro Tools folder

The name matches the name in the 
Avid application bin

Contents of Pro Tools folder (left pane) and sequence 
listed in that directory (right pane)

The red dots in the illustration indicate that 
the system has placed a reservation on the 
files to prevent unauthorized deletion for a 
fixed period of time. For more information, 
see the Avid Interplay Access User’s Guide.

For details on exporting audio and video us-
ing Media Composer 2.5 and higher, see 
“Exporting Audio and Video from Media 
Composer 2.5 and Higher” on page 27.

Red dots “_v1_forPT” appended to the 
sequence name
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Using the Send To Templates to 
Export an AAF or OMF Using 
Versions of Media Composer Prior 
to 2.5

The Send To Templates option lets you create 
one metadata AAF or OMF file that references 
audio and video files used in the sequence, and 
save it to the volume selected in your Avid Pref-
erences.

To use the Send To Digidesign Pro Tools 
templates:

1  Select a sequence in a bin.

2  Choose File > Send To > Digidesign Pro Tools, 
then choose one of the following options:

Link to Audio and Video Creates a sequence 
which links to existing audio and video wher-
ever possible and only creates new media files 
for effects that have not been rendered. 

Choose this option for a single-user scenario in 
which Pro Tools will link to the same media files 
as the current Avid sequence. Use this setting if 
the media files are currently stored on volumes 
that are suitable for Pro Tools media playback 
and recording.

Consolidate-Link Audio and Video Exports only 
the portion of the audio and video files that are 
actually used in the edited sequence. One se-
quence file is created, along with a new file for 
each clip in the timeline. This is similar to the 
Consolidate command in Pro Tools. New files 
are created in the formats specified in the Media 
Creation and Audio Project Settings dialogs. 

Consolidating media will place new files on 
drives specified in those dialogs. New video files 
will be stored in the OMFI MediaFiles folder (for 
OMF) or the Avid MediaFiles folder (for MXF). 
You should be certain that the drives to which 
you are exporting currently have no media in 
those folders.

Choose this option for a multi-user scenario in 
which the Pro Tools editor only needs access to 
the material in the sequence and is likely work-
ing on a different computer or volume.

3  If you want to view or change export settings, 
click the Options button, and then make any 
changes (such as switching from the default AAF 
to the OMF format). If you make any changes, 
you can use the Save As Template button to cre-
ate a new template.

4  Click Set.

AAF exports ignore in and out marks, but 
QuickTime exports do not. The default tem-
plates that create QuickTime movies auto-
matically deselect the “Use in and out 
marks” option.

Send To Link to Audio and Video dialog

This workflow assumes that you use the de-
fault values. This means that you are ex-
porting using the Project sample rate, audio 
file format, and sample bit depth.
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5  Navigate to the location where you want the 
AAF or OMF files to reside.

6  Click OK.

The Avid application exports the files to the des-
tination folder. If the Avid application has to 
transcode video files to a new resolution, render 
effects or perform audio file conversions, a new 
sequence appears in the bin with the name file-
name.Export.01, and a new audio master clip ap-
pears in the bin with the name filename.new.01.

Manually Exporting an AAF 
Sequence Using Versions of Media 
Composer Prior to 2.5

Once all effects have been rendered, export the 
sequence as an AAF sequence.

To manually export an AAF sequence:

1  Select the sequence in the bin.

2  Select File > Export.

3  Type a name and select a location for the ex-
ported sequence.

4  Select Export to Pro Tools from the Export Set-
tings menu at the bottom of the Export As dia-
log.

5  Click the Options button to open the Export 
to Pro Tools Settings dialog. Verify the settings:

• For Export As, select AAF.

• Select the Include All Video Tracks in Se-
quence option. When the sequence is im-
ported into Pro Tools. All of the video 
tracks will be “flattened” so that the im-
ported sequence shows only a single video 
stream.

• Deselect the Include All Audio Tracks in Se-
quence option if you do not want to export 
any audio.

6  In the Video Details tab, select one of the fol-
lowing from the Export Method pop-up menu:

Link to Current Media The Pro Tools session will 
link to the same video files as the current Avid 
sequence. 

You will need to render all video effects be-
fore manually exporting the sequence.

Export As dialog

Export Settings – Export To Pro Tools dialog, Video 
Details tab
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Choose this setting in a single-user scenario in 
which the video files are currently stored on a 
volume suitable for Pro Tools video playback 
(such as a MediaNetwork volume).

Copy Media and Link to Copied Media New com-
plete video files will be created on the desig-
nated volume. 

Choose this option in a multi-user scenario in 
which the Pro Tools user is receiving the se-
quence for the first time and will copy the media 
to their respective Workspace.

Consolidate and Link to Consolidated Media Sim-
ilar to Copy Media, but only the parts of the 
video clips which are actually used in the Time-
line are copied. 

Choose this setting in a multi-user scenario in 
which the Pro Tools user may already be work-
ing on media from the sequence, and will copy 
the changed material to their respective Work-
space.

The following settings may also appear under 
the Video Details tab, depending on the selected 
export method:

Destination Folder Choose where to store copied 
video files.

Target Drive for Consolidate Choose the target 
drive for consolidated video. New video files will 
be stored on that drive in the OMFI MediaFiles 
folder (for OMF) or the Avid MediaFiles folder 
(for MXF). You should be certain that the drives 
to which you are exporting currently have no 
media in those folders. You cannot save these 
export settings until you have highlighted a tar-
get volume. Striped drives appear in bold type.

Handle Length Extends the beginning and end 
of the consolidated file by the specified number 
of frames. This lets you trim edits later, though 
the sequence would need to be re-edited in the 
Avid application. 

Render Video Effects Always select Render Video 
Effects. If you already manually rendered effects, 
selecting this option will not create new files. It 
is highly recommended that all effects be ren-
dered manually before exporting the sequence.

Transcode Video To Use this only if you need to 
change the video resolution. Pro Tools with an 
Avid video peripheral supports all resolutions 
supported by Avid applications, so in most cases 
this will not be necessary.

7  Click the Audio Details tab, and select one of 
the following from the Export Method pop-up 
menu:

Do not use either Embed Media or Consoli-
date and Embed Media for video files. 
Pro Tools does not support embedded video 
files in AAF sequences.

If your Pro Tools system is running on a 
slower computer, you may be able to reduce 
some of the CPU load in Pro Tools by 
transcoding the video to 1:1 on export. 1:1 
video is uncompressed, and consequently it 
does not need to be decompressed before 
playing back. However, 1:1 video requires 
significant amounts of storage space.

Export Settings dialog, Audio Details tab
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Link to Current Media The Pro Tools session will 
link to the same audio files as the current Avid 
sequence. Choose this setting in a single-user 
scenario in which the audio files are currently 
stored on a volume suitable for Pro Tools audio 
playback (such as a MediaNetwork volume).

Copy Media and Link to Copied Media New com-
plete audio files will be created on the desig-
nated volume. 

Choose this option in a multi-user scenario in 
which the Pro Tools user is receiving the se-
quence for the first time and will copy the media 
to their respective Workspace.

Consolidate and Link to Consolidated Media Sim-
ilar to Copy Media, but only the parts of the au-
dio files which are actually used in the Timeline 
are copied. 

Choose this setting in a multi-user scenario in 
which the Pro Tools user may already be work-
ing on media from the sequence, and will copy 
the changed material to their respective Work-
space.

The following settings may also appear under 
the Audio Details tab, depending on the selected 
export method:

Render All Audio Effects Select the Render All 
Audio Effects option so that all audio effects are 
rendered before export. If you already manually 
rendered effects, selecting this option will not 
create new files. It is highly recommended that 
all effects be rendered manually before export-
ing the sequence.

Include Rendered Audio Effects Select the In-
clude Rendered Audio Effects option. Otherwise, 
the exported sequence will include the original 
audio files without any AudioSuite effects from 
the original sequence—even if those effects were 
previously rendered.

Convert Audio Sample Rate/Bit Depth/File For-
mat Select Project for any of these, and the cur-
rent Audio Project Setting will be used.

8  Click Save or Save As in the Export Settings di-
alog:

• Click Save to use the specified settings 
whenever Export to Pro Tools is selected 
from the Export Settings menu. These set-
tings will also be used when choosing File > 
Send To > Digidesign Pro Tools. 

• Click Save As to save these settings as a pre-
set with a different name. These settings 
can then be recalled in the Export dialog. If 
you click Save As instead of Save, the Ex-
port to Pro Tools settings will not be 
changed.

9  Click Save in the Export As dialog. (The Export 
Settings cannot be saved until you have selected 
a target drive for both audio and video.)

When the export is complete, you are ready to 
import the file into Pro Tools.

To export only part of a sequence:

1  Choose Clip > New Sequence to create a new 
sequence.

Do not use either Embed Media or Consoli-
date and Embed Media for video media. 
Pro Tools does not import the video from 
AAF sequences containing embedded video.

For more information on opening and im-
porting AAF sequences in Pro Tools, see 
“Importing Audio and Video into 
Pro Tools” on page 43. For more informa-
tion on the Import Session dialog, see the 
Pro Tools Reference Guide.
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2  In the bin, name the sequence and drag it to 
the Record Monitor.

3  Drag your original sequence to the Source 
Monitor.

4  Use the controls underneath the Source Mon-
itor to locate the first frame of the portion of the 
clip that you want to edit into the sequence:

• To begin playing the clip, click Play (or 
press the Spacebar). Click Play or press the 
Spacebar again to Pause.

• To move to the beginning of the clip, click 
Rewind (or press the Home key).

• To move to the end of the clip, click Fast-
Forward (or press the End key).

• To nudge by frame, click Step Forward 1 
Frame or Step Backward 1 Frame (or press 
the Left/Right Arrow keys).

• To scrub, click and drag the cursor beneath 
the Source Monitor. (Enable the Caps Lock 
to hear audio while scrubbing.)

5  Click Mark In to mark the In point (the first 
frame of the selected portion of the clip) at the 
current position of the cursor.

6  Using the same controls, locate the last frame 
of the portion of the clip that you want to edit 
into the sequence. 

7  Click Mark Out to mark the Out point (the last 
frame of the selected portion of the clip) at the 
current position of the cursor.

8  Click the Record Monitor to select the empty 
sequence, then press the Home key to move the 
cursor to the beginning of the sequence.

9  Click the Overwrite or Splice-In button. The 
selected portion of old sequence is edited into 
the empty sequence in the Record Monitor.

Follow the preceding steps for exporting the 
new sequence.

Creating a Video Mixdown Using 
Versions of Media Composer Prior 
to 2.5

Video mixdown combines a sequence (or por-
tion of a sequence) into one video file that re-
flects all edits and effects processing. Creating a 
video mixdown is a manual process prior to Me-
dia Composer 2.5 and higher. With Media Com-
poser 2.5 and higher, an option exists in AAF ex-
port to create a video mixdown automatically.

Avid Media Composer main window

Source Monitor controls

Rewind

Fast-For-
ward

Step Forward
1 Frame

Cursor

Play/
Pause

Step Backward
1 Frame

Mark
Out

Mark
In

Clear Both
Marks

Mark
Clip

You can also select the entire clip by clicking 
Mark Clip.

Overwrite and Splice-In buttons

OverwriteSplice-In
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You can mix down multiple video tracks or a 
single track. For mixdowns of multiple tracks, 
the selected track and all tracks under it are com-
bined into one file that always reflects the top-
most visible track.

To create a video mixdown:

1  Open the bin containing the sequence you 
want to mix down.

2  Drag the sequence to the Record Monitor. The 
tracks comprising the sequence display in the 
Timeline.

3  Do one of the following:

• To combine multiple video tracks into the 
mixdown, select a video track, then click 
the Record Track Monitor button next to 
the track. Video tracks above the selected 
track will not be included in the mixdown.

– or –

• To select only one video track for mix-
down, Control-click (Windows) or Com-
mand-click (Macintosh) the Record Track 
Monitor button. The button will turn 
green.

4  On the Timeline or in the Record Monitor, 
drag the cursor to the position in the sequence 
at which you wish the mixdown to start. (Press 
the Home key to move the cursor to the begin-
ning of the Timeline.)

Creating a video mixdown is analogous to 
bouncing to disk in Pro Tools, except that 
the video mixdown creates only video and 
no audio.

Layered video tracks in a video mixdown

Record and Source Monitors

Track layers reflected
in video mixdown

Record Track monitor

Record Track monitor

Record Track
Monitor

Record Track
Monitor (solo)
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5  Under the Record Monitor, click the Mark In 
button to mark the In point at the beginning of 
the sequence.

6  Drag the cursor to the position at which you 
want the sequence to end. (Press the End key to 
move the cursor to the end of the sequence.)

7  Click Mark Out button to set the Out point.

The portion of the sequence you have selected 
will be mixed down.

8  Choose Special > Video Mixdown.

9  From the Target bin pop-up menu, choose the 
bin where you wish to store the master clip of 
the video mixdown.

10  From the Target Drive pop-up menu, choose 
the volume where you wish to save the video 
mixdown. On the volume you select, MXF files 
are stored in the Avid MediaFiles folder, and 
OMF files are stored in the OMFI MediaFiles 
folder.

11  Choose a file resolution for the video mix-
down from the Resolution pop-up menu.

12  Click OK.

A progress bar displays as the Avid application 
saves the video mix to the location and resolu-
tions you have specified.

Importing Audio and Video 
into Pro Tools
To import sequences exported from Avid appli-
cations into Pro Tools, you can choose from the 
following methods:

• Importing an AAF or OMF sequence as a 
Pro Tools session

• Importing an AAF or OMF sequence into an 
existing Pro Tools session

• Importing a video mixdown into Pro Tools

• Importing an AAF sequence into Pro Tools 
from Interplay (Pro Tools Avid Interplay 
Option and an Avid Interplay system re-
quired)

Importing an AAF or OMF 
Sequence as a Pro Tools Session

The easiest way of using Pro Tools to edit a se-
quence exported from an Avid application is to 
open it as a new session. 

To open an AAF (or OMF) sequence as a Pro Tools 
session:

1  Launch Pro Tools.

2  Choose File > Open Session.

3  In the Open Session dialog, navigate to the 
AAF or OMF sequence you want to import.

Record Monitor controls

Video Mixdown dialog

Mark
Out

Mark
In
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4  Click Open.

5  Name your session in the File Name field.

6  Select the I/O Settings to use for the session. 
Several pre-configured I/O Settings are included 
with your system, or you can select a custom I/O 
Setting that you have created.

7  Click Save.

The Import Session Data dialog appears.

Pro Tools New Session dialog

Import Session Data dialog

Pro Tools lets you open and import OMF or 
AAF sequences that reference audio files 
with mixed sample rates and/or bit depths. 
Audio files will be converted to the highest 
sample rate and bit depth of the files being 
imported (for new sessions) or to the current 
sample rate and/or bit depth (for existing 
sessions). 
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8  From the Audio Media Options pop-up menu, 
choose how you want to import audio files into 
Pro Tools:

• If the audio files reside on a volume from 
which Pro Tools can play back audio, select 
Link to Source Media (Where Possible).

• If the audio files reside on a volume from 
which Pro Tools cannot play back audio, 
select Copy from Source Media to copy all 
audio to the Pro Tools audio storage or 
Consolidate from Source Media to copy 
only the portions of the audio used in the 
Pro Tools Timeline to the Pro Tools audio 
storage.

9  From the Video Media Options pop-up menu, 
choose how you want to import video files into 
Pro Tools:

• If the video files reside on a volume from 
which Pro Tools can play back video, select 
Link to Source Media.

• If the video files reside on a volume from 
which Pro Tools cannot play back video, se-
lect Copy from Source Media to copy all 
video to the Pro Tools video storage.

10  Change other parameters as desired. For 
more information, see “Exporting Audio from 
Pro Tools for Avid Editing Applications” on 
page 51.

11  Click OK.

Pro Tools will create a new Audio Files folder, a 
Fade Files folder, a Video Files folder, a 
cache.wfm file, and a session file at the desig-
nated locations. This session will match the au-
dio file type, sample rate, and bit depth of the 
audio in the OMF or AAF you selected.

Importing an AAF or OMF 
Sequence into an Existing Session

You can import an AAF or OMF sequence con-
taining audio and video media into an existing 
Pro Tools session. 

To open and import audio and/or video tracks from 
an OMF or AAF sequence:

1  Open an existing Pro Tools session.

2  Choose File > Import > Session Data, and 
choose the AAF or OMF sequence that you wish 
to import.

Any video imported into Pro Tools must be 
the same frame rate as video already placed 
in the Timeline. 

Pro Tools cannot play video that is embed-
ded in an AAF or OMF sequence, but it can 
read the video editing metadata when im-
ported into a satellite track. Do not use this 
option if you want to import the video itself 
into Pro Tools. 

You can also open an AAF or OMF sequence 
by dragging it from any location on your 
computer or the DigiBase browser to the 
Pro Tools Timeline.
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3  From the Audio Media Options pop-up menu, 
choose how you want to import audio files into 
Pro Tools:

• If the audio files reside on a volume from 
which Pro Tools can play back audio, select 
Link to Source Media (Where Possible).

• If the audio files reside on a volume from 
which Pro Tools cannot play back audio, 
select Copy from Source Media to copy all 
audio to the Pro Tools audio storage or 
Consolidate from Source Media to copy 
only the audio used in the session to the 
Pro Tools audio storage.

4  From the Video Media Options pop-up menu, 
choose how you want to import video files into 
Pro Tools:

• If the video files reside on a volume from 
which Pro Tools can play back video, select 
Link to Source Media.

• If the video files reside on a volume from 
which Pro Tools cannot play back video, se-
lect Copy from Source Media to copy all 
video to the Pro Tools video storage.

5  In the Import Session Data dialog, deselect 
any source tracks that you do not want to be im-
ported. (If you are importing Session Data from 
AAF or OMF sequences, all tracks are selected by 
default. If you are importing tracks from a 
Pro Tools session, no tracks are selected by de-
fault.)

6  Click OK.

7  If your audio or video source media is on a vol-
ume that is not suitable for playback (shown as a 
Transfer volume in the Workspace browser) or if 
your MediaNetwork workspace privileges are 
read-only, Pro Tools displays a dialog that guides 
you to copy the media to a volume designated 
for Playback or Record. (Click Yes.)

Pro Tools imports the audio and video media to 
the Timeline. Audio tracks with mixed sample 
rates and/or bit depth are automatically con-
verted to the same sample rate and bit depth as 
the session.

Now you are ready to edit the audio files in 
Pro Tools.

Import Session Data dialog

If there are any errors or region name trun-
cations, a dialog will appear asking you if 
you want a detailed report of the changes. 
Click Yes and choose where you want to 
save the log.
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Drive Selection When Importing 
Session Data

When using the Import Session Data dialog to 
import audio files with Copy or Consolidate 
Source selected in the Audio Media Options 
pop-up menu, all new audio files are stored on 
the volumes designated for their respective tar-
get tracks in the Disk Allocation dialog.

Selecting a Unity Workspace When 
Importing Session Data

When using the Import Session Data dialog to 
import audio files with Copy or Consolidate 
Source selected in the Audio Media Options 
pop-up menu, all new audio files are stored on 
the volumes designated for their respective tar-
get tracks in the Disk Allocation dialog.

When importing video files (such as from a CD), 
the video files are copied by default to the same 
volume that holds the session file. To have the 
files copied to another volume, open the Work-
space browser, and select T in the volume desig-
nation column for all volumes except the vol-
ume where you want the video to be stored. To 
ensure that the files are not copied to the root 
level of the volume, create a folder with the ses-
sion name on the desired Unity workspace, then 
create a folder within that session folder named 
Video Files.

Importing an Avid Video Mixdown 
into Pro Tools
(Versions of Media Composer Prior to 2.5 Only)

You can import an OMF or MXF video file into 
Pro Tools. You might do this, for example, to 
import a video mixdown created in the Avid ap-
plication.

To import Avid video into Pro Tools:

1  Create a new Pro Tools session or open an ex-
isting session.

2  Choose File > Import > Video.

3  In the Select Video File to Import dialog, lo-
cate the video file in the Avid MediaFiles folder 
(MXF) or OMFI MediaFiles folder (OMF) stored 
on your video storage.

4  Click Open.

Pro Tools imports the video file into the Video 
track.

Importing a Sequence into 
Pro Tools from Interplay
(Avid Interplay System Only)

This section describes how to locate a sequence 
that has been exported to the Interplay database 
from the Avid application and import it into 
Pro Tools. This section assumes that you have 
already configured the Pro Tools Import settings 
in the Interplay Administration tool. 

Select Video Files to Import dialog

For more information, see the Pro Tools 
Avid Interplay Guide.
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If you do not establish Pro Tools Import Settings 
before importing the sequence into Pro Tools, 
you can select the appropriate values in the Im-
port Session Data dialog during the import pro-
cess.

When importing a sequence from Interplay into 
Pro Tools, you can import into a new or existing 
session. 

Importing a Sequence into Pro Tools 
from within Interplay

To check out the sequence and import it into 
Pro Tools from within Avid Interplay Access:

1  If you want to import the sequence into an ex-
isting session in Pro Tools, launch Pro Tools and 
open that session.

2  Start Avid Interplay Access.

3  Navigate to the Pro Tools folder containing 
the sequence you want to import.

4  Right-click the sequence, and choose Import 
to Digidesign Pro Tools.

Importing a Sequence from Interplay 
from within Pro Tools

This section describes to how to use Pro Tools to 
import a sequence from Interplay. If you have 
not yet opened Interplay Access and specified a 
server to connect to, you must do that before 
performing this procedure. 

To check out the sequence and import it into 
Pro Tools from within Pro Tools:

1  Start Pro Tools.

2  If you want to import the sequence into an ex-
isting session, open that session.

3  Choose File > Import > Sequence from Avid 
Interplay.

Navigating to the sequence

Importing a sequence into Pro Tools from within Access

See “Importing a Sequence into Pro Tools 
from within Interplay” on page 48 for de-
tailed information.
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The Interplay Engine Browser appears.

4  In the Interplay Engine Browser, expand the 
Interplay database by clicking the plus sign (+) 
next to it.

5  Expand the root folder of the database—usu-
ally titled AvidWG or a variation thereof—by 
clicking the plus sign (+) next to its name. 

6  Expand the Projects folder.

7  Expand the project containing the sequence 
you want to check out and import to Pro Tools.

The Logon to Interplay dialog appears.

8  Enter your username and password, and click 
OK.

9  In the Interplay Engine Browser, locate and se-
lect the sequence that you want to import.

10  Click OK. 

11  If the Name the Session dialog appears, nav-
igate to the appropriate location either on local 
storage or on a dedicated Unity workspace, and 
click Save.

Interplay Engine Browser

The folder structure matches the structure in 
Interplay Access.

Logon to Interplay dialog

Interplay
database

Interplay Engine Browser (folder structure displayed)

Files that appear in greyed out text out are 
not available for import into Pro Tools.

Name the Session dialog

This dialog does not appear if you are im-
porting a sequence into an existing session.
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12  If the Pro Tools Import Session Data dialog 
appears, select the appropriate options and click 
OK.

Pro Tools imports the sequence, copies any me-
dia (if the settings require copying), and displays 
the imported sequence within the Pro Tools ses-
sion. 

Editing Audio in Pro Tools
Audio files created in the Avid application are ei-
ther OMF or MXF files, which Pro Tools cannot 
edit destructively.

When you use Pro Tools to perform a destruc-
tive edit (such as using AudioSuite processing to 
replace the original sound), it creates a new copy 
of the file and leaves the original untouched.

Import Session Data dialog

This dialog does not appear if you config-
ured the Pro Tools Import Settings in the 
Avid Interplay Administrator. Pro Tools au-
tomatically uses those settings to import the 
sequence. (See the Pro Tools Avid Interplay 
Guide for detailed information on configur-
ing Pro Tools Import Settings, and the Digi-
Translator Guide for detailed information 
on setting options in this dialog.)

If the sequence was linked to media files on 
unmounted volumes, the system provides a 
warning and asks you to mount those vol-
umes before you proceed with copying or 
linking to media.

Sequence imported from Interplay into the Timeline

See the Pro Tools Reference Guide for de-
tailed information on editing audio files in 
Pro Tools.
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Exporting Audio from 
Pro Tools for Avid Editing 
Applications
In Pro Tools, you can export audio tracks for use 
in the Avid application using any of the follow-
ing commands:

• Exporting selected tracks as an AAF or OMF

• Bouncing to disk

• Exporting selected regions as files

• Exporting edited audio tracks to Interplay 
from Pro Tools (Avid Interplay system re-
quired)

For other export methods, see the Pro Tools Ref-
erence Guide.

Exporting Tracks as OMF/AAF 
Sequences

Use Export Selected Tracks as OMF/AAF to ex-
port individual tracks or an entire Pro Tools ses-
sion in AAF or OMF format.

To export selected audio tracks from Pro Tools as 
an AAF (or OMF) sequence:

1  In Pro Tools, select the tracks you want to ex-
port in the Pro Tools session by Shift-clicking 
the names of each track.

2  Choose File > Export > Selected Tracks as 
OMF/AAF.

3  Under OMF/AAF Options, choose AAF (or 
OMF) from the Export As pop-up menu.

4  Select Enforce Avid Compatibility.

Enforce Avid Compatibility creates frame-accu-
rate edits, wraps the files as OMFI (unless you 
choose MXF), and limits the sample rate options 
to 44.1 or 48 kHz. Dithering without noise shap-
ing will be applied to files being exported from 
24-bit to 16-bit.

5  Ensure that the Target Project Time Code For-
mat pop-up menu displays the correct frame 
rate for the Avid project. 

6  Click OK. 

Tracks are exported in their entirety and 
time selections are ignored.

Volume and pan automation is not retained 
on export if Quantize Edits to Frame Bound-
aries is enabled (Avid Compatibility Mode).

The Movie track cannot be exported to AAF 
or OMF from Pro Tools.

Pro Tools Export to OMF/AAF dialog

An OMF sequence cannot reference MXF 
media files. In the Export Selected Tracks as 
OMF/AAF dialog, MXF is only available 
when AAF is selected in the Export As pop-
up menu
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7  In the Publishing Options dialog, type the 
Pro Tools Comment and Sequence Name. 

8  Click OK.

Pro Tools will create a sequence with the name 
you supply. (The Pro Tools comment appears in 
the Avid bin in a Pro Tools Comment column.)

9  In the Name the AAF/OMF File to Export dia-
log, navigate to a folder where you can easily lo-
cate the Pro Tools composition when it is time 
to import it into the Avid application.

10  Click Save.

11  In the Please Choose a Folder for Converted 
Audio Files dialog, do one of the following:

• If you are exporting to the same storage 
that Avid application will be accessing, 
navigate to the OMFI MediaFiles folder 
(AIFF or WAV files) or the Avid MediaFiles 
folder (MXF files).

– or –

• If you are exporting to a location that is not 
directly accessible to the Avid application, 
navigate to a location where you can easily 
find the audio files when you need to copy 
them over to the Avid computer.

12  Click Use Current Folder (Windows) or 
Choose (Macintosh).

Pro Tools exports the following files:

• The AAF or OMF sequence is saved to the 
folder you designated.

• If you exported audio files directly to the 
Avid application video storage, related me-
dia is saved to the appropriate volume and 
folder (OMFI MediaFiles or Avid Media-
Files) accessible to the Avid application.

Pro Tools Publishing Options dialog

Pro Tools Name the AAF File to Export dialog (OMF 
dialog not shown)

Do not save the sequence to either the OMFI 
Media Files folder or the Avid Media Files 
folder.

Navigating to the OMFI MediaFiles folder (OMF media) 
or Avid MediaFiles folder (AAF media)
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13  Do one of the following:

• If you are using the Avid application on the 
same computer as Pro Tools and are ready 
to use it to import the files you just ex-
ported from the Avid application, exit 
Pro Tools.

– or –

• If you were unable to save the audio por-
tion of the AAF sequence directly to storage 
that is accessible from the Avid application, 
copy the audio files from their saved loca-
tion to the OMFI MediaFiles folder (for 
AIFF or WAV media) or Avid MediaFiles 
folder (for MXF media) on a drive con-
nected to your Avid system.

Exporting Audio Files Using 
Bounce to Disk

Use the Bounce to Disk command to create pre-
mixed files of the current Pro Tools session. This 
does not export all of the individual files on the 
Timeline, but it does guarantee that the mix you 
hear in the Avid application will be identical to 
the mix you hear in Pro Tools, including all pan-
ning, effects and automation.

To export audio files using Bounce to Disk:

1  In Pro Tools, finalize the mix.

2  Select the time range of the session that you 
want to export. (All audible tracks in that time 
range will be included in the bounce, whether 
they are selected or not.)

3  Choose File > Bounce to > Disk.

4  Select the Enforce Avid Compatibility option.

Enforce Avid Compatibility creates frame-accu-
rate edits, wraps the files as OMFI (unless you 
choose MXF), and limits the sample rate options 
to 44.1 or 48 kHz. Dithering without noise shap-
ing will be applied to files being bounced from 
24-bit to 16-bit.

5  Choose a file type from the File Type pop-up 
menu.

6  Click Bounce.

7  In the Publishing Options dialog, type the 
Pro Tools Comment and Clip Name.

If you selected more than one region for export, 
the Clip Name field will not be available and the 
names of the regions will be used for the ex-
ported files.

Bounce to Disk dialog

Publishing Options dialog



Pro Tools Unity MediaNetwork Guide54

8  Choose the Target Project Time Code Format. 

9  Click OK.

10  In the Save Bounce As dialog, navigate to the 
volume you will use for audio playback in the 
Avid application. 

• For MXF audio files, ensure the file is saved 
to the Avid MediaFiles folder.

• For all other audio files, ensure the file is 
saved to the OMFI MediaFiles folder.

11  Click Save.

All audible audio in the selection will be ex-
ported to two multi-mono audio files.

Exporting Edited Audio Tracks to 
Interplay from Pro Tools
(Media Composer 2.6 or Higher and Avid 
Interplay Systems Only)

After you edit the audio material from the se-
quence, you can export the audio tracks back 
into the sequence in Interplay.

To export audio tracks from Pro Tools, and then 
check in audio tracks to Interplay:

1  In Pro Tools, select the tracks that you want to 
export into the Pro Tools sequence on Interplay.

2  Select File > Export > Selected Tracks to Se-
quence in Avid Interplay.

3  In the Export Comment dialog, type a com-
ment and click OK.

4  In the Replace or Add Selected Tracks dialog, 
select a method for laying back edited audio ma-
terial into the Pro Tools sequence residing on 
the Interplay server:

Replace with Selected Tracks Replaces the old 
audio tracks in the Pro Tools sequence with the 
edited audio tracks. Select this option if you do 
not want to preserve the original audio in the se-
quence. 

It is recommended that you provide com-
pleted audio stems rather than audio tracks 
with edits.

Export Comment dialog
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Add Selected Tracks Adds the edited audio 
tracks to the Pro Tools sequence on the Inter-
play database. Select this option if you want to 
preserve the original audio in the sequence.

5  Click OK.

A confirmation message box appears.

6  Click OK.

The sequence in the Avid Interplay database is 
now ready to be checked out and imported by 
the Avid application.

Importing Audio into an Avid 
Application from Pro Tools
Once you have exported audio files or sequences 
from Pro Tools, you may import them into a bin 
in the Avid application.

Importing Audio Files into a Bin

To import audio files into the Avid application:

1  Launch the Avid application, and open the de-
sired project.

2  Open the bin into which you wish to import 
the audio files from Pro Tools.

3  Choose Tools > Media Tool. 

The Media Tool Display lets you scan all media 
files in both the OMFI MediaFiles and Avid Me-
diaFiles folders.

4  Select the Master Clips and the Media Clip op-
tions.

When adding selected tracks, ensure that 
the total number of tracks in the sequence 
residing on the Interplay server does not ex-
ceed the total allowed number of tracks for 
an Avid application—24 audio and 24 
video tracks.

Replace or Add Selected Tracks dialog

Media Tool Display
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5  Under the Media Drives list, do one of the fol-
lowing:

• Select the drives that contain media files 
for your project.

– or –

• Click All Drives to select all applicable 
drives for scanning.

6  Under the Projects list, click All Projects to 
scan all available media files.

7  Click OK.

The Media Tool window appears, displaying the 
media you selected.

8  To sort the files in the bin by a specific column 
(such as Name or Creation Date), right-click the 
column and select “Sort on Column, Ascend-
ing” or “Sort on Column, Descending.”

9  In the Media Tool window, select the Stereo 
(or multi-mono) master clip exported from 
Pro Tools.

10  Drag the master clip to the bin.

11  Close the Media Tool.

12  To preview the contents of the imported au-
dio clip, double-click the audio clip in the bin. 
The audio clip will open in a pop-up monitor.

Importing an AAF Audio Sequence 
into a Bin

To import an AAF sequence into the Avid 
application:

1  Launch the Avid application, and open the de-
sired project.

2  Select the bin where you would like to import 
the sequence.

3  Choose File > Import.

4  In the Select Files to Import dialog, navigate to 
the sequence you wish to import, and ensure the 
correct drive is selected for audio.

5  Click Open. The new audio sequence appears 
in the selected bin, along with all related audio 
clips.

One of the following occurs:

• If you imported an AAF sequence containing 
embedded audio, the Avid application auto-
matically copies the embedded audio to either 
the Avid MediaFiles folder or the OMFI Medi-
aFiles folder.

– or –

• If you imported an AAF sequence that refer-
ences audio—and the Avid editing application 
does not have direct access to the audio—you 
must copy the audio files from the Pro Tools 
audio storage to either the Avid Media Files 
folder or the OMFI MediaFiles folder.

6  To hear the contents of the imported audio se-
quence, double-click the audio sequence in the 
bin. The audio sequence opens in a pop-up 
monitor or in the Timeline (depending on your 
Bin settings). Press the Spacebar to play. 

Media Tool
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Importing Pro Tools Audio Files 
Back into the Avid Editing 
Application
(Media Composer 2.6 or Higher and Avid 
Interplay Systems Only)

After you have checked out the completed audio 
stems to the Pro Tools sequence on the Interplay 
server, you must import the sequence back into 
the Avid application.

To import the sequence back into the Avid editing 
application:

1  In the Avid application, open the Interplay 
Window and navigate to the location of the 
checked in Pro Tools sequence.

2  Drag the sequence into the bin.

The Avid application checks out the sequence 
and imports it and its related files into the bin.

3  You can now do one of the following: 

• Add the new audio tracks into the original 
sequence.

– or –

• Work with the imported sequence.

In this example, the Pro Tools audio tracks are 
added into the original sequence.

4  Load the imported sequence into the Source 
monitor.

5  Add the audio into the original sequence us-
ing standard editing techniques. 

Interplay browser

Depending on edits made in Pro Tools, you 
might see several audio files with names 
containing the prefix “Sample accurate 
edit.” For more information, see “Frame-
Rate Accurate Video Editing and Sample-
Rate Accurate Audio Editing” on page 58.

Pro Tools folder Files checked in by 
the Pro Tools editor

Bin after import

If you plan to check in the sequence to Inter-
play for Pro Tools again, it is simpler to im-
port the audio into the original sequence. 
Every time you export a sequence for 
Pro Tools, the system appends the text 
“_vx_forPT,” where x is the number of 
times the sequence has been exported. It can 
become confusing if several similar text 
strings are appended to the name.

For more information, see the documenta-
tion (PDF or Help file) for your Avid editing 
application.

Imported
sequence

Video mixdown
created during

first check in to
Interplay

Original
sequence
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The following illustration shows the audio 
tracks cut into the original sequence. In this ex-
ample, the original tracks are overwritten. 

6  Now you can use the Avid application to make 
any adjustments to the sequence and do the fol-
lowing:

• Create a digital cut.

• Perform a Send to Playout operation.

• Check in the sequence to Interplay for 
Pro Tools if the Pro Tools editor needs to 
work on the sequence again.

Frame-Rate Accurate Video Editing and 
Sample-Rate Accurate Audio Editing

After a sequence has been exported back to In-
terplay from Pro Tools, a number of additional 
media files appear in the Interplay Window and 
in the bin. Some have names containing the 
prefix Sample accurate edit. These are the addi-
tional media files that Pro Tools creates to make 
sure that the Avid application receives frame-ac-
curate audio. Sample-accurate edit media files 
are visible if you zoom in on portions of the im-
ported audio in the Timeline.

The following illustration shows Sample accu-
rate edit files in the Interplay Window.

Avid video editing applications edit with frame 
accuracy. This means that when using an Avid 
application to work on a 30-fps project, you can 
edit at 30 different locations for every one sec-
ond of video. Pro Tools edits with sample rate 
accuracy. In a 48 kHz session, there are poten-
tially 48,000 locations to edit for every second of 
audio. 

When Pro Tools exports a sequence, it must en-
sure that the audio media files line up on frame 
boundaries. To do this, it might have to split an 
existing audio region into three regions. For ex-
ample, the following illustration shows a 5-
frame video clip and a corresponding audio re-
gion. In Pro Tools, the audio regions might not 
line up on video frame boundaries.

Sequence in the Avid Timeline after overwrite

Sample-accurate edits in the Interplay window

The original audio clip does not line up on video frame 
boundaries

Sample-accurate 
edit audio files

1 Pro Tools
audio region

5 frame
video clip
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In order to export frame accurate audio regions, 
Pro Tools splits the audio media on frame 
boundaries and fills any gaps with silence. The 
following illustration shows the resulting audio 
regions that are exported to the Avid applica-
tion.

To cut down on the number of sample accurate 
edit files, the Pro Tools editor can perform a 
Bounce to disk for each track (or a bus-record to 
an audio track) rather than exporting tracks that 
contain all of the audio edits. 

Synchronizing Audio with an 
Avid Sequence
Once you have imported an audio file or se-
quence from Pro Tools into a bin in the Avid ap-
plication, you can synchronize it with video. 
This is especially useful for verifying sync with 
the original video sequence, then laying audio 
and video back to tape or creating a digital 
movie with your final mix.

To synchronize an edited audio file or sequence 
with the original video sequence:

1  Ensure that the audio exported from Pro Tools 
is now residing in a bin within your current 
project.

2  Drag the original sequence to the Record 
Monitor to see all elements in the Timeline.

The original sequence displays in the Timeline.

3  Drag the imported audio clip or sequence 
from the bin to the Source Monitor. New Source 
Track buttons for the source appear to the left of 
the Track buttons for the Timeline.

Exported audio regions line up on video frame 
boundaries

3 exported
audio regions

5 frame video
clip

New audio regions 
padded with silence

Record and Source Monitors

Original sequence displays in Timeline

New track buttons

Timeline
Track
buttons

Source
Track
buttons

Timeline
Track
buttons
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4  Use the controls underneath the Source Mon-
itor to locate the first frame of the portion of the 
clip that you want to edit into the sequence:

• To begin playing the clip, click Play (or 
press the Spacebar). Click Play or press the 
Spacebar again to Pause.

• To move to the beginning of the clip, click 
Rewind (or press the Home key).

• To move to the end of the clip, click Fast-
Forward (or press the End key).

• To nudge by frame, click Step Forward 1 
Frame or Step Backward 1 Frame (or press 
the Left/Right Arrow keys).

• To scrub, click and drag the cursor beneath 
the Source Monitor. (Enable the Caps Lock 
to hear audio while scrubbing.)

5  Click Mark In to mark the In point (the first 
frame of the selected portion) at the current po-
sition of the cursor.

6  Using the same controls, locate the last frame 
of the portion of the source that you want to 
edit into the sequence. 

7  Click Mark Out to mark the Out point (the last 
frame of the selected portion) at the current po-
sition of the cursor.

The portion of the audio source between the In 
point and the Out point is now selected for ed-
iting into the sequence.

8  Choose Clip > New Audio Track to add audio 
tracks to the sequence. (This leaves any original 
audio tracks in place to compare synchroniza-
tion.) Add a new track for each channel of audio 
you want to add.

Source Monitor controls

Enable the Caps Lock to hear audio while 
scrubbing.

Rewind

Fast-
Forward

Step Forward 1 
Frame

Cursor

Play/ 
Pause

Step Backward 1 
Frame

Mark 
Out

Mark 
In

Clear Both 
Marks

Mark 
Clip

You can also select the entire source clip or 
sequence by clicking Mark Clip.

You can also click the Clear Both Marks 
button to clear the In and Out points.

Audio tracks in the Timeline

Existing
audio
tracks

New audio
tracks
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9  If necessary, click on the Source track buttons 
and drag to the desired new Timeline track but-
tons so that the new media will be placed on the 
correct tracks in the Timeline.

10  If the original audio tracks still display yellow 
speaker icons, click the speaker icons in the 
Track Enable button to mute them. The speaker 
icons for the original tracks will disappear, and 
the speaker icons should appear yellow in the 
new tracks, indicating that they will be heard.

11  If the video track and the original audio 
tracks are enabled (gray), disable them and en-
able the new audio tracks (purple), by clicking 
the correct audio track buttons (A1–A24). This 
will ensure that only the new tracks will be af-
fected by any editing commands.

12  In the Timeline, place the cursor at the posi-
tion where you want to lay the new audio into 
the Timeline. (Press Home to move to the begin-
ning of the sequence.)

13  Under the Record Monitor, click the Clear 
Both Marks button to remove any In and Out 
points (if present).

Aligning Source audio tracks with Timeline audio tracks

Clicking the speaker icons to disable Source tracks

Source
Track linked
to Timeline
track

Linking
Source track
to Timeline
track

Speaker
icons

New audio tracks in Timeline

Timeline containing two empty audio tracks

Record Monitor controls

Enabled
tracks

Disabled
tracks

Clear Both
Marks
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14  Click the Overwrite button to lay the audio 
into the Timeline.

The audio selected between the In and Out 
points in the Source Monitor is laid into the 
Timeline at the position of the cursor.

15  If you want to display audio waveforms in 
the Timeline, click the Fast Menu (located on 
the lower left hand corner of the Timeline), and 
choose Audio Data > Energy Plot. Ensure that 
the new audio tracks appear synchronized with 
the originals.

16  If necessary, make sure the video track’s Mon-
itor button is enabled (purple). This will allow 
you to view the video portion of the sequence in 
the Record Monitor (or client monitor).

17  Press the Home key to move the cursor to the 
beginning of the sequence and press the Space-
bar to play the sequence. The new audio should 
be synchronized with the video.

After verifying the new audio sequence is cor-
rectly synchronized, you can do either of the 
following:

• Lay audio and video back to tape using Dig-
ital Cut.

– or –

• Export your sequence as a QuickTime, 
MPEG, or other format digital movie.

Overwrite and Splice-In buttons

Timeline with new audio sequence

Fast menu

OverwriteSplice-In

New audio tracks 
from Pro Tools

Fast menu

Enabling the Video track

Monitor
button
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appendix a

PCI and PCIe Slot Configurations for Avid 
Video Peripherals

This appendix covers PCI and PCIe slot configurations for Pro Tools|HD systems with Avid video pe-
ripherals on Windows and Mac. These slot configurations have been qualified and recommended by 
Digidesign.

Summary of Recommended Windows PCI and PCIe Slot 
Configurations
This section summarizes qualified and recommended PCI and PCIe slot configurations for the follow-
ing Windows machines with or without expansion chassis, for both local and shared storage:

• HP xw8400

• HP xw9300

• Dell Precision 690 750w

HP xw8400

HP xw8400 with host cards (shared storage)

• ATTO Celerity FC-41ES PCIe host card to 4 GB Unity MediaNetwork

• ATTO Celerity FC-41XS PCI host card to 4 GB Unity MediaNetwork 

• ATTO FC 3300 PCI host card to 2/4 GB Unity MediaNetwork

See “Shared Storage Slot Configurations for HP xw8400 with Host Cards” on page 67.
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HP xw8400 with expansion chassis (shared storage)

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card, using ATTO Celerity FC-41XS PCI 
host card to 4 GB Unity MediaNetwork

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe 
host card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork 

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41XS PCI host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41XS PCI host 
card to 4 GB Unity MediaNetwork

HP xw8400 with expansion chassis (local storage)

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

HP xw9300

HP xw9300 with host cards (shared storage)

• ATTO Celerity FC-41ES PCIe host card to 4-GB Unity MediaNetwork 

• ATTO Celerity FC-41XS PCI host card to 4 GB Unity MediaNetwork 

• ATTO FC 3300 PCI host card to 2/4 GB Unity MediaNetwork

HP xw9300 with expansion chassis (shared storage)

• Digidesign Expansion|HD PCI Chassis, using ATTO Celerity FC-41XS PCI card to 4 GB Unity Medi-
aNetwork 

• Digidesign Expansion|HD PCI Chassis, using ATTO Celerity FC-41ES PCIe card to 4 GB Unity Me-
diaNetwork

See “Shared Storage Configurations for HP xw8400 with Expansion Chassis” on page 69.

See “Local Storage Configurations for HP xw8400 with Expansion Chassis” on page 72.

See “Shared Storage Slot Configurations for HP xw9300 with Host Cards” on page 74.

See “Shared Storage Slot Configurations for HP xw9300 and Digidesign Expansion|HD Chassis” on 
page 76.
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HP xw9300 with expansion chassis (local storage) 

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

Dell Precision 690 750W

Dell Precision 690 750W with host cards (local storage)

• ATTO Celerity FC-41ES PCIe host card to 4 GB Unity MediaNetwork 

Dell Precision 690 750W with expansion chassis (shared storage)

• Magma 64-bit 7-Slot Expansion PCI Chassis, with ATTO Celerity FC-41ES PCIe host card to 4 GB 
Unity MediaNetwork 

• Magma 64-bit 7-Slot Expansion PCI Chassis, using ATTO Celerity FC-41XS PCI host card to 4 GB 
Unity MediaNetwork 

• Magma 64-bit 7-Slot Expansion PCI Chassis, using ATTO FC 3300 PCI host card to 2/4 GB Unity 
MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

Dell Precision 690 750W with expansion chassis (local storage)

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

See “Local Storage Slot Configurations for HP xw9300 with Expansion Chassis” on page 78.

See “Local Storage Configurations for Dell Precision 690 750w Host Cards” on page 80.

See “Shared Storage Configurations for Dell Precision 690 750w with Expansion Chassis” on 
page 81.

See “Local Storage Configurations for Dell Precision 690 750w with Expansion Chassis” on page 83.
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Summary of Mac PCI and PCIe Slot Configurations
This section summarizes qualified and recommended PCI and PCIe slot configurations for the follow-
ing Mac machines for local storage with or without expansion chassis:

• Apple Mac Pro

• Apple G5 PCI

• Apple G5 PCIe

Apple Mac Pro

• Apple Mac Pro with host cards

• Apple Mac Pro with Magma PE6R4

• Apple Mac Pro with Digidesign Expansion|HD Chassis

Apple G5 PCI

• Apple G5 PCI with host cards

• Apple G5 PCI with Magma 64-bit 7-Slot Expansion Chassis and PCI Host Card

• Apple G5 PCI with Digidesign Expansion|HD Chassis and PCI Host Card

Apple G5 PCIe

• Apple G5 PCIe with host cards

• Apple G5 PCIe with Magma 64-bit 7-Slot Expansion Chassis and PCI Host Card

• Apple G5 PCIe with Digidesign Expansion|HD Chassis and PCI Host Card

See “Apple Mac Pro” on page 85.

See “Apple G5 PCI” on page 86.

See “Apple G5 PCIe” on page 88.
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HP xw8400 PCI and PCIe Slot Configurations
This section describes qualified and recommended PCI and PCIe slot configurations for HP xw8400.

Shared Storage Slot Configurations for HP xw8400 with Host Cards

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw8400 
systems, connected to shared storage via the following host cards:

• ATTO Celerity FC-41ES PCIe host card to 4 GB Unity MediaNetwork

• ATTO Celerity FC-41XS PCI host card to 4 GB Unity MediaNetwork 

• ATTO FC 3300 PCI host card to 2/4 GB Unity MediaNetwork

HP xw8400: ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) ATTO Celerity FC-41ES PCIe card

CPU Slot 5 (133MHz PCI 64-bit) HD Core card

CPU Slot 6 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 7 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card
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HP xw8400: ATTO Celerity FC-41XS PCI Host Card to 4 GB Unity MediaNetwork

HP xw8400: ATTO FC 3300 PCI Host Card to 2 GB/4 GB Unity MediaNetwork

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

CPU Slot 6 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 7 (100MHz PCI 64-bit) HD Core card

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) HD Core card
Warning: Do not insert an ATTO FC 3300 card into any 133MHZ PCI slot. 
This will cause damage to your HBA card and may also cause data loss 
on the server.

CPU Slot 6 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 7 (100MHz PCI 64-bit) ATTO FC 3300 PCI card
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Shared Storage Configurations for HP xw8400 with Expansion Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw8400 
systems, with the following expansion chassis and host cards connected to shared storage:

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card, using ATTO Celerity FC-41XS PCI 
host card to 4 GB Unity MediaNetwork

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe 
host card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork 

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41XS PCI host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41XS PCI host 
card to 4 GB Unity MediaNetwork

HP xw8400 and Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI Host Card: 
ATTO Celerity FC-41XS PCI Host Card to 4 GB Unity MediaNetwork

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Magma 7 Slot 64-Bit Chassis PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw8400 with Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI Host Card: 
ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCI Host Card:
ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) ATTO Celerity FC-41ES PCIe card

CPU Slot 5 (133MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) ATTO Celerity FC-41ES PCIe card

CPU Slot 5 (133MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCIe Host Card:
ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCI Host Card:
ATTO Celerity FC-41XS PCI Host Card to 4 GB Unity MediaNetwork

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Digidesign Expansion|HD Host PCIe card

CPU Slot 4 (PCIe) ATTO Celerity FC-41ES PCIe card

CPU Slot 5 (133MHz PCI 64-bit) Untested

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCIe Host Card:
ATTO Celerity FC-41XS PCI Host Card to 4 GB Unity MediaNetwork

Local Storage Configurations for HP xw8400 with Expansion Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw8400 
systems, with the following expansion chassis and host cards connected to local storage:

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Digidesign Expansion|HD Host PCIe card

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Untested

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw8400 and Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI Host Card

HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCIe Host Card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Magma 7 Slot 64-Bit Chassis PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Digidesign Expansion|HD Host PCIe card

CPU Slot 5 (133MHz PCI 64-bit) Untested

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)



Pro Tools Unity MediaNetwork Guide74

HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCI Host Card

HP xw9300 PCI and PCIe Slot Configurations
This section describes qualified and recommended PCI and PCIe slot configurations for HP xw9300 
computers for use with Avid video peripherals.

Shared Storage Slot Configurations for HP xw9300 with Host Cards

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw9300 
systems connected to shared storage via the following host cards:

• ATTO Celerity FC-41ES PCIe host card to 4-GB Unity MediaNetwork 

• ATTO Celerity FC-41XS PCI host card to 4 GB Unity MediaNetwork 

• ATTO FC 3300 PCI host card to 2/4 GB Unity MediaNetwork 

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw9300: ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

HP xw9300: ATTO Celerity FC-41XS PCI Host Card to 4 GB Unity MediaNetwork

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) ATTO Celerity FC-41ES PCIe card

CPU Slot 4 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 5 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 6 (133MHz PCI 64-bit) HD Core card

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

CPU Slot 5 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 6 (133MHz PCI 64-bit) HD Core card
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HP xw9300: ATTO FC 3300 PCI Host Card to 2 GB/4 GB Unity MediaNetwork

Shared Storage Slot Configurations for HP xw9300 and Digidesign 
Expansion|HD Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw9300 
systems and the Digidesign Expansion|HD PCI Chassis, with the following host cards connected to 
shared storage:

• ATTO Celerity FC-41XS PCI card to 4 GB Unity MediaNetwork 

• ATTO Celerity FC-41ES PCIe card to 4 GB Unity MediaNetwork 

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) ATTO FC 3300 PCI card

CPU Slot 5 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 6 (133MHz PCI 64-bit) HD Core card
Warning: Do not insert an ATTO FC 3300 card into any 133MHZ PCI slot. 
This will cause damage to your HBA card and may also cause data loss 
on the server.
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HP xw9300 and Digidesign Expansion|HD PCI Chassis with PCI Host Card:
ATTO Celerity FC-41XS PCI Card to 4 GB Unity MediaNetwork

HP xw9300 and Digidesign Expansion|HD PCI Chassis with PCI Host Card:
ATTO Celerity FC-41ES PCIe Card to 4 GB Unity MediaNetwork

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) Untested

CPU Slot 5 (100MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

CPU Slot 6 (133MHz PCI 64-bit) Expansion|HD Host PCI Card

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) ATTO Celerity FC-41ES PCIe card

CPU Slot 4 (100MHz PCI 64-bit) Untested

CPU Slot 5 (100MHz PCI 64-bit) Untested

CPU Slot 6 (133MHz PCI 64-bit) Expansion|HD Host PCI Card

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Local Storage Slot Configurations for HP xw9300 with Expansion 
Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw9300 
systems, with the following expansion chassis and host cards connected to local storage:

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

HP xw9300 and Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI Host Card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) Untested

CPU Slot 5 (100MHz PCI 64-bit) Untested

CPU Slot 6 (133MHz PCI 64-bit) Magma 64-bit Expansion HBA card

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw9300 and Digidesign Expansion|HD PCI Chassis with PCIe Host Card

HP xw9300 and Digidesign Expansion|HD PCI Chassis with PCI Host Card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Expansion|HD Host PCIe Card

CPU Slot 4 (100MHz PCI 64-bit) Untested

CPU Slot 5 (100MHz PCI 64-bit) Untested

CPU Slot 6 (133MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) Untested

CPU Slot 5 (100MHz PCI 64-bit) Untested

CPU Slot 6 (133MHz PCI 64-bit) Expansion|HD Host PCI Card

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)



Pro Tools Unity MediaNetwork Guide80

Dell Precision 690 750w Recommended PCI and PCIe Slot 
Configurations
This section describes qualified and recommended PCI and PCIe slot configurations for Dell 
690 750w computers for use with Avid video peripherals.

Local Storage Configurations for Dell Precision 690 750w Host Cards

This section describes qualified and recommended PCI and PCIe slot configurations for Dell Precision 
690 750W systems with the following cards in the host:

• ATTO Celerity FC-41ES PCIe host card to 4 GB Unity MediaNetwork 

ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork
 

Slot Card

CPU Slot 1 (PCIe x8) ATTO Celerity FC-41ES PCIe card

CPU Slot 2 (100MHz PCI 64-bit) HD Core card

CPU Slot 3 (100MHz PCI 64-bit) Optional: HD Accel, HD Process

CPU Slot 4 (33MHz PCI 32-bit) Optional: HD Accel, HD Process

CPU Slot 5 (PCIe x8) Untested

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested
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Shared Storage Configurations for Dell Precision 690 750w with 
Expansion Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for Dell Precision 
690 750W with the following expansion chassis and host cards connected to shared storage:

• Magma 64-bit 7-Slot Expansion PCI Chassis, with ATTO Celerity FC-41ES PCIe host card to 4 GB 
Unity MediaNetwork 

• Magma 64-bit 7-Slot Expansion PCI Chassis, using ATTO Celerity FC-41XS PCI host card to 4 GB 
Unity MediaNetwork 

• Magma 64-bit 7-Slot Expansion PCI Chassis, using ATTO FC 3300 PCI host card to 2/4 GB Unity 
MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

Dell Precision 690 750w and Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI 
Host Card: ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

Slot Card

CPU Slot 1 (PCIe x8) ATTO Celerity FC-41ES PCIe card

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Magma 7 Slot 64-Bit Chassis PCI card

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) Untested

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Dell Precision 690 750w and Digidesign Expansion|HD PCI Chassis with PCI Host 
Card: ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

Dell Precision 690 750w and Digidesign Expansion|HD PCI Chassis with PCIe Host 
Card: ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

Slot Card

CPU Slot 1 (PCIe x8) Untested

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) ATTO Celerity FC41-ES PCIe card

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot Card

CPU Slot 1 (PCIe x8) Digidesign Expansion|HD Host PCIe card

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Untested

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) ATTO Celerity FC41-ES PCIe card

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Local Storage Configurations for Dell Precision 690 750w with 
Expansion Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for Dell Precision 
690 750W systems, with the following expansion chassis and host cards connected to local storage:

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

Dell Precision 690 750w and Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI 
Host Card

Slot Card

CPU Slot 1 (PCIe x8) Untested

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Magma 7 Slot 64-Bit Chassis PCI card

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) Untested

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Dell Precision 690 750w and Digidesign Expansion|HD PCI Chassis with PCIe Host 
Card

Dell Precision 690 750w and Digidesign Expansion|HD PCI Chassis with PCI Host 
Card

Slot Card

CPU Slot 1 (PCIe x8) Digidesign Expansion|HD Host PCIe card

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Untested

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) Untested

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot Card

CPU Slot 1 (PCIe x8) Untested

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) Untested

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Mac PCI and PCIe Slot Configurations
This section describes qualified and recommended PCI and PCIe slot configurations for Apple Mac 
machines.

Local Storage Configurations for Apple Mac Pro

This section describes qualified and recommended PCI and PCIe slot configurations for the following 
Apple Mac Pro systems:

• Apple Mac Pro

• Apple Mac Pro and Magma PE6R4 chassis with PCIe host card

• Apple Mac Pro and Digidesign Expansion|HD chassis with PCIe host card

Apple Mac Pro

Apple Mac Pro and Magma PE6R4 Chassis with PCIe Host Card

Digidesign does not support shared storage via Avid Unity MediaNetwork or Avid Unity ISIS on 
Mac OS X.

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 HD Core card

CPU Slot 3 Optional: HD Accel or HD Process card

CPU Slot 4 (133MHz 64-bit) Optional: HD Accel card, HD Process card, SCSI PCIe card, FireWire PCIe 
card

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Magma 6 Slot PE6R4 PCIe card

CPU Slot 3 Optional: SCSI PCIe card or FireWire PCIe card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCIe card or FireWire PCIe card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Apple Mac Pro and Digidesign Expansion|HD Chassis with PCIe Host Card

Local Storage Configurations for Apple G5 PCI

This section describes qualified and recommended PCI slot configurations for the following Apple G5 
PCI systems:

• Apple G5 PCI

• Apple G5 PCI with Magma 64-bit 7-slot expansion chassis and PCI host card

• Apple G5 PCI with Digidesign Expansion|HD chassis and PCI host card

Apple G5 PCI

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Digidesign Expansion|HD Host PCIe card

CPU Slot 3 Optional: SCSI PCIe card or FireWire PCIe card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCIe card, FireWire PCIe card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 HD Core card

CPU Slot 3 Optional: HD Accel or HD Process card

CPU Slot 4 (133MHz 64-bit) Optional: PCI SCSI HBA, FireWire card, or Intel Pro/1000MT
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Apple G5 PCI with Magma 64-bit 7-Slot Expansion Chassis and PCI Host Card

Apple G5 PCI with Digidesign Expansion|HD Chassis and PCI Host Card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Magma 7 Slot 64-Bit Chassis PCI card

CPU Slot 3 Optional: SCSI PCI card or FireWire PCI card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCI card, FireWire PCI card, or Intel Pro/1000MT 
PCI card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Digidesign Expansion|HD Host PCI card 

CPU Slot 3 Optional: SCSI PCI card or FireWire PCI card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCI card, FireWire PCI card, or PCI Intel 
Pro/1000MT

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Local Storage Configurations for Apple G5 PCIe

This section describes qualified and recommended PCIe slot configurations for the following Apple 
G5 PCIe systems:

• Apple G5 PCIe

• Apple G5 PCIe with Magma 64-bit 7-slot expansion chassis and PCIe host card

• Apple G5 PCIe with Digidesign Expansion|HD chassis and PCIe host card

Apple G5 PCIe

Apple G5 PCIe with Magma 64-bit 7-Slot Expansion Chassis and PCIe 
Host Card

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 HD Core card

CPU Slot 3 Optional: HD Accel or HD Process card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCIe or FireWire PCIe card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Magma 7 Slot 64-Bit Chassis PCIe card

CPU Slot 3 Optional: SCSI PCIe or FireWire PCIe card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCIe or FireWire PCIe card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Apple G5 PCIe with Digidesign Expansion|HD Chassis and PCIe Host Card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Digidesign Expansion|HD Host PCIe card 

CPU Slot 3 Optional: SCSI PCIe or FireWire PCIe card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCIe or FireWire PCIe card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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